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  إدارة المشاريع
أ٘ذحفٙخ عٛحء وخٔض طعظزش ادحسس حٌّشخس٠ع حٌّلٛس حلاعخعٟ فٟ طلم١ك ٔـخف ٚط١ّض حٌّٕظّخص عٍٝ حخظلاف 

ِغاظلذع ٌراشع طٍه حٌّشاخس٠ع طماذَ ِٕظـاخص ٚخاذِخص ؿذ٠اذس , أٚ ؽاشف رشِـ١اخص كذ٠ؼاش , أٚ أٞ ٔظاخَ 

ططز١مٗ , ٌزٌه فؤْ ادحسس حٌّشخس٠ع طغخعذ حٌّٕظّش فٟ ِٛحؿٙش حٌظلذ٠خص ٚحٌّظر١شحص حٌز١ج١ش حٌظٟ طل١ؾ رٙخ , 

ٌزح ٠ظٛؿذ عٍٝ حٌّٕظّش أْ طخظخس ِذسحء ٌّشخس٠عٙخ ٠ّؼٍْٛ فٟ حٌلم١مش لخدس ٌفشق حٌعًّ حٌظٟ عظمَٛ رظٕف١از 

ٌّااٛحسد , ٠ااذ٠ش حٌّخااخؽش حٌظااٟ عااظٛحؿٗ حٌّشااشٚ, , حٌّشااشٚ, , لاْ لخثااذ حٌّشااشٚ, عااٛف ٠خطااؾ , ٠اإظُ ح

 ٠ٚظلمك ِٓ وخفش حٌّٙخَ حٌظٟ لذ طُ أـخص٘خ , ٚأْ عٍغٍش حلأٔشطش حٌّخطؾ ٌٙخ لذ ٔفزص رذْٚ طٍىئ أٚ فشً .

 رؼشيف انًششٔع  

ٕ٘خن عذس طعش٠فخص ٌٍّششٚ, طخظٍف ٘زح حٌظعش٠فخص رخخظلاف ٚؿٙخص ٔظش حٌزاخكؼ١ٓ ٚحٌذحسعا١ٓ فاٟ ِـاخي 

 -ّشخس٠ع ِٚٓ ػّٓ ٘زٖ حٌظعش٠فخص ٟ٘ :ادحسس حٌ

رؤٔٗ )ِـّٛعش ِٓ حلأٔشطش حٌّظشحرطش غ١ش حٌشٚط١ٕ١ش , ٌٙخ رذح٠خص ٚٔٙخ٠خص ص١ِٕش ِلذدس , انًششٔع ٠عشف 

٠ظُ طٕف١ز٘خ ِٓ لزً شخض أٚ ِٕظّش ٌظلم١ك أ٘ذحف ِلذدس , فاٟ أؽاخس ِعاخ١٠ش حٌىٍفاش , ٚحٌاضِٓ , ٚحٌـاٛدس 

 حٌّخطؾ ٌٙخ(

عٍااٝ أٔااٗ  Project Management"حٌّشااشٚ, فااٟ وظخرااٗ حٌّٛعااَٛ  فمااذ عااشف  Gupta, كٕثزااب أِااخ 

طظـٗ ٔـٛ ٘اذف ِلاذد ِٚائؽشس رٛلاض ِلاذٚد ِٚظاُّ ػآّ )ِـّٛعش ِظشحرطش ِٓ حلأٔشطش ٚحلأكذحع 

 طخظض ِع١ٓ( .

ظلم١ااك ٘ااذف ِعاا١ٓ أٔـااخصٖ ٠ا١ِٛٓ أٚ أوؼااش ٌعشفظااٗ )أٔاٗ حٌـٙااذ حٌاازٞ ٠غااظرشق  انًٕعاإػخ انجشينبَ ااخأِاخ 

 اٌٝ ِـّٛعش ِٓ حٌفعخ١ٌخص حلإدحس٠ش ٚحٌٕٙذع١ش ٚحلالظظخد٠ش(ٚطلظخؽ 

عشفاض حٌّشاشٚ, رؤٔاٗ )حٌـٙاذ حٌازٞ ٠غاظرشق أٔـاخصٖ خّغاش  انًٕعٕػخ الايشيك خ نهُٓذعخ انظاُبػ خأِخ 

 ٌظلم١ك ٘ذف ِع١ٓ ٠ٚلظخؽ اٌٝ ِـّٛعش ِٓ حٌفعخ١ٌخص حلإدحس٠ش ٚحٌٕٙذع١ش ٚحلالظظخد٠ش( . أ٠خَ أٚ أوؼش

طعشفٗ رؤٔاٗ )حٌـٙاٛد حٌّئلظاش حٌّٛؿٙاش ٔلاٛ ط١ٌٛاذ ّٔاٛرؽ  الايشيكي لإداسح انًششٔػبد انًؼٓذ انقٕييأِخ 

ِٕفشد أٚ حٌخذِش حٌّٕفشدس ٚحٌّمظٛد رخٌّئلض ٘ٛ وً ِششٚ, ٠لذد رٕٙخ٠ش , ٚحٌّمظٛد رخٌّٕفشد لاْ حٌّٕظؾ 

 أٚ حٌخذِش طخظٍف رشىً أٚ رآخش عٓ ؿ١ّع حٌّٕظـخص ٚحٌخذِخص حٌظم١ٍذ٠ش( . 

عشفظااٗ رؤٔااٗ )ع١ٍّااش فش٠اذٖ طلظااٛٞ عٍااٝ ِـّٛعاش ِاآ حٌفعخ١ٌااخص حٌّظٕخعاامش  ًٕاطاا خ انذٔن اخيُظًااخ انأِاخ 

ٚحٌّغاا١طش ع١ٍٙااخ ٚحٌظااٟ ٌٙااخ طااخس٠ه رذح٠ااش ٚٔٙخ٠ااش ِٚٛؿااٗ ٔلااٛ طلم١ااك ٘ااذف ِلااذد ٚفمااخ  ٌّظطٍزااخص ِلااذدس 

 ٚطشًّ )حٌضِٓ , حٌىٍفش , حٌّٛحسد( .
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ٚعخص ٚحٌظر١شحص حٌظاٟ ٠ّىآ أْ ططاشأ ع١ٍاٗ ٚأْ ٚع١ٍٗ فؤْ ادحسس حٌّششٚ, طٙظُ ٚرشىً وز١ش رظمذ٠ُ حٌّشش

حٌّمظٛد رّٕظّش حٌّششٚ, ٘ٛ فشق حٌعًّ حٌظٟ طمَٛ رم١اخدس ادحسحص حٌّشاشٚ, ِٕاز حٌّشكٍاش حلأٌٚاٝ ٌٚلا١ٓ 

 أٔـخصٖ ٚطغ١ٍّش اٌٝ حٌـٙش حٌّغظف١ذس ِٓ حٌّششٚ, .

ِاآ حٌعٕخطااش ٠ـااذ فّاآ خاالاي حٌظعش٠فااخص حٌظااٟ طااُ روش٘ااخ عااخرمخ  ٠ّىاآ حٌظٛطااً اٌااٝ أٔااٗ ٕ٘خٌااه ِـّٛعااش 

 -طٛحفش٘خ فٟ ِفَٙٛ حٌّششٚ, :

 حٌّششٚ, ٌٗ أٔشطش ِظشحرطش ٚغ١ش سٚط١ٕ١ش . -1

 حٌّششٚ, ٠ظىْٛ ِٓ أٔشطش ِظشحرطش ٌٙخ رذح٠خص ٚٔٙخ٠خص ص١ِٕش ِلذدس . -2

 حٌّششٚ, ٌٗ فظشس ص١ِٕش ِلذدس . -3

 حٌّششٚ, ٌٗ ِٛحصٔش طمذ٠ش٠ش ِخظظش رٙخ حلأِٛحي حٌلاصِش ٌٙزح حٌّششٚ, . -4

 ٘ذف ٠ـذ طلم١مٗ عٛحء وخْ ٘زح حٌٙذف ٠ظّؼً فٟ عٍعش أٚ خذِش أٚ ِٕظؾ فش٠ذ .حٌّششٚ, ٌٗ  -5

 ٠ـذ طلم١ك ِعخ١٠ش حٌىٍفش ، ٚحٌضِٓ ٚحٌـٛدس حٌّٕخعزش ٚحٌّطٍٛرش ِٓ لزً حٌعّلاء . -6

،  Peogectٚفاااٟ ِٕخلشاااظٕخ لإدحسس حٌّشاااشٚ, ٠ىاااْٛ ِااآ حٌّف١اااذ أ٠ؼاااخ  حٌظ١١ّاااض رااا١ٓ ِظاااطٍق حٌّشاااشٚ, 

،  Work Package، ِٚظاطٍق كاضَ حٌعّاً  Task، ِٚظطٍق حٌّّٙاش  Programِٚظطٍق حٌزشٔخِؾ 

 -٘زح ٚلذ طُ حٌظعشع ٌظعش٠ف حٌّششٚ, عخرمخ  :،  Work unitsِٚظطٍق ٚكذحص حٌعًّ 

فٙاٛ ِـّٛعاش ِآ حٌّشاشٚعخص حٌّظشاخرٙش حٌظاٟ طغاخُ٘ فاٟ طلم١اك أ٘اذحف ؽ٠ٍٛاش  -أيب رؼشياف انجشَابيح  

 حلأؿً ٌٍّٕظّش .

 أكذ عٕخطش حٌعًّ حٌّٛؿٛد فٟ حٌّششٚ, ، ٚرخوظّخٌٙخ ٠ىظًّ حٌّششٚ, .فٟٙ  -ٔرؼشيف انًًٓخ  

 فٟٙ عٕظش ؿضثٟ ٌٍّّٙش ٚرظلم١مٙخ ٠ىظًّ طلم١ك حٌّّٙش . -أيب رؼشيف زضو انؼًم  

٠ٚمظاذ رٙاخ طـضثاش كاضَ حٌعّاً اٌاٝ أٚحِاش عّاً ٚرخوظّاخي ٘ازٖ حلأٚحِاش طىظّاً  -ٔرؼشيف ٔزذاد انؼًم  

 حٌّظطٍلخص ٚحٌّفخ١ُ٘ حٌغخرمش رّؼخي خخص رزشٔخِؾ ٌٍظذس٠ذ .كضِش حٌعًّ ٠ّٚىٓ طٛػ١ق ٘زٖ 

فزشٔخِؾ حٌظذس٠ذ ٠ظىْٛ ِٓ ِـّٛعاش ِآ حٌّشاخس٠ع ٚحٌّشاشٚ, ٠ظىاْٛ ِآ ِـّٛعاش ِآ حٌّٙاخَ ٚحٌّّٙاش 

 طظىْٛ ِٓ ِـّٛعش ِٓ كضَ حٌعًّ ، ٚكضَ عًّ حٌّششٚ, طظىْٛ ِٓ ِـّٛعش ِٓ ٚكذحص حٌعًّ .

 -٠ظىْٛ ِٓ ح٢طٟ : حٌٕظُ ، رّعٕٝ أْ حٌّششٚ, ٚحٌّششٚ, ٠ّىٓ أْ ٠غظٕذ اٌٝ ٔظش٠ش

ٚطظىااْٛ ٘اازٖ حٌّااذخلاص ِاآ سغزااخص حٌعّاالاء ، ٚحٌّااٛحد ٚحٌّااٛحسد حٌزشااش٠ش ٚحٌؼمخفااش  -انًااذت د   -1

 حٌظٕظ١ّ١ش ٚح١ٌٙخوً حٌظٕظ١ّ١ش ، ٚحٌّعٍِٛخص حٌلاصِش ٌظٕف١ز حٌّششٚ, .

ٌظٕظ١ُ ، ٚحٌشلخرش ، ٚحٌظىٌٕٛٛؿ١اخ ِؼً أطخخر حٌمشحسحص ، ٚحٌظخط١ؾ ، ٚح -آن بد انؼًم ٔانًؼبندبد   -2

 حٌلاصِش ، ٌظل٠ًٛ حٌّذخلاص اٌٝ ِخشؿخص .

 -، ٚطظّؼً فٟ ح٢طٟ : انًخشخبد -3
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 عٍع ٍِّٛعش ٚفش٠ذس . - أ

 خذِخص ِظ١ّضس ٚفش٠ذس . - د

 أفىخس ِٚعٍِٛخص . - ص

طغظخذَ ٌرشع طظل١ق حلألشحفاخص ٌٚراشع حٌاظعٍُ ٚحٌاذسٚط حٌّغاظفخدس ِآ  -انزغزيخ انشاخؼخ   -4

 طٕف١ز حٌّششٚعخص حٌّخظٍفش ٚحٌّظٕٛعش .

 تظبئض انًششٔع  

طشظشن حٌّشخس٠ع ِّٙخ طٕٛعض ٚحخظٍفض ؽز١عظٙخ فٟ ِـّٛعش ِٓ حٌخظخثض حٌظٟ ط١ّض٘خ عآ غ١ش٘اخ ِآ 

  -أٔٛح, حٌّٕظّخص حلأخشٜ ِٚٓ أُ٘ ٘زٖ حٌخظخثض ٟ٘ :

طمخَ حٌّشخس٠ع عخدس  ٌظٕف١ز غشع ِع١ٓ , أٚ كً ِشىٍش ِع١ٕٗ , ٚطلم١ك أ٘ذحف  -  Purpose)انغبيخ ) -1

 ِلذدس ٚع١ٍٗ فؤْ ٚؿٛد حٌّششٚ, ٠ىْٛ ِشطزطخ  رظلم١ك ٘زٖ حٌرخ٠ش ٚحٌٛطٛي اٌٝ طٍه حلأ٘ذحف.

خص أْ ٌٍّشاشٚ, دٚسس ك١اخس ِظىخٍِاش ِؼاً حٌّٕظّا -  (Limited life Cycleدٔسح ز ابح يساذٔدح ) -2

حٌذحثّش , ك١غ طزذأ دٚسس ك١خس حٌّششٚ, رخٌفىشس ػُ حٌظخطا١ؾ ٚحٌظٕف١از ٚحٌشلخراش ٚأخ١اشح  ِشكٍاش حلأظٙاخء 

)حٌظغ١ٍُ( , ألا حْ ِخ ١ّ٠ض دٚسس ك١خس حٌّششٚ, ٘ٛ أٔٙخ رحص ؽز١عاش ِئلظاش رل١اغ أٔٙاخ طزاذأ ٚطٕظٙاٟ فاٟ 

 أٚلخص ِلذدس .

حٌّششٚعخص فٟ حٌّٕظّش ِع رعؼٙخ حٌزعغ , عخدس طظذحخً  -  Infer dependencies)انزذات د ) -3

ٚطظذحخً أ٠ؼخ  ِع حلألغخَ حٌٛظ١ف١ش حلأخاشٜ فاٟ حٌّٕظّاش ِآ أظاخؽ ٚطغا٠ٛك ٚط٠ّٛاً ِٚاٛحسد رشاش٠ش 

 ٚغ١ش٘خ ِٓ طذحخلاص .

وً ِشاشٚ, ٌاٗ ِضح٠اخ ٚخظاخثض ٠ظ١ّاض رٙاخ عآ أٞ ِشاشٚ, أخاش ,  -  Uniqueness)الاَ شاديخ ) -4

 حٌّظٕٛعش ٚٚعخثٍٗ حٌّخظٍفش ٌظلم١ك ٘زٖ حلأ٘ذحف .فٍىً ِششٚ, خظٛط١ش ٚأ٘ذحفٗ 

حٌّشخس٠ع طٛحؿٗ طشحعخص ِخظٍفش عٛحء ِع رعؼٙخ حٌازعغ فاٟ حٌّٕظّاش حلأَ  - ( Conflict) ُضاعان -5

أٚ ِع حلألغخَ حٌٛظ١ف١ش حلأخشٜ فٟ حٌّٕظّش , ٚحٌغزذ فٟ حٌظاشح, ٘اٛ حٌّاٛحسد ٚحلإِىخ١ٔاخص حٌّلاذدس 

ق حٌعّااً فااٟ حٌّشااخس٠ع حٌّخظٍفااش أٚ طااشحعخص ِظٕٛعااش راا١ٓ فااٟ حٌّٕظّااش , ٚواازٌه طااشحعخص راا١ٓ فااش

 حلأؽشحف رحص حٌعلالش حٌّّٙش رخٌّششٚ, ِٓ عّلاء ١ٌِّٛٚٓ ِٚٛسد٠ٓ ٚحلإدحسس حٌع١ٍخ ٌٍّٕظّش .

ٌىً ِشاشٚ, ِـّٛعاش ِآ حٌم١اٛد ٚحٌّلاذدحص طماف أِاخَ طٕف١ازٖ ٚطخظٍاف  -  Constraints)انق ٕد ) -6

  -خ عٍٝ حٌظى١١ف ٚحٌظؤلٍُ ِٚٓ ٘زٖ حٌم١ٛد ِخ ٠ٍٟ :٘زٖ حٌم١ٛد رخخظلاف حٌّششٚعخص ٚلذسطٙ

 حٌٛلض حٌلاصَ ٌظٕف١ز حٌّششٚ, . - أ

 ل١ّش حٌظىخ١ٌف حٌخخطش رّششٚ, ِع١ٓ طخظٍف عٓ ِششٚ, آخش . -حٌظىٍفش : - د
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٠غعٝ وً ِششٚ, اٌٝ طلم١ك ١ِضس طٕخفغ١ش ٌٗ طـخٖ حٌّشخس٠ع حلأخشٜ حعاظـخرش ٌشغزاخص  -حٌـٛدس : - ص

 ّش .ٚحكظ١خؿخص حٌعّلاء فٟ حٌّٕظ

ٟٚ٘ ِـّٛعش حٌّظر١شحص حٌّغظّشس عاٛحء فاٟ حٌز١جاش حٌذحخ١ٍاش أٚ حٌخخسؿ١اش ٚحٌظاٟ طخظٍاف  -حٌز١جش : - ع

 ِٓ ِششٚ, اٌٝ ِششٚ, آخش .

فٍىً ِششٚ, ٌٗ ل١ُ ٚػمخفش طٕظ١ّ١ش طخظٍف عٓ حٌما١ُ ٚػمخفاش أٞ ِشاشٚ,  -حٌؼمخفش حٌظٕظ١ّ١ش ٚحٌم١ُ : - ؽ

   آخش .

  إداسح انًششٔعProject Management 

 حٌلخؿش اٌٝ ادحسس حٌّشخس٠ع ؟ ِخ ٘ٛ حٌّمظٛد ربدحسس حٌّشخس٠ع ؟ ٌّخرح ادحسس حٌّشخس٠ع .ِخ ٟ٘ 

طعٕٟ ِـّٛعش حٌفعخ١ٌخص ٚحلأٔشطش حٌظٟ طعًّ ِاع رعؼاٙخ حٌازعغ ِآ طخطا١ؾ ٚطٕظا١ُ  -إداسح انًشبسيغ  

ٚفخع١ٍش ٚػّٓ ٚطٛؿ١ٗ ِٚشحلزش ٌرشع حلاعظخذحَ حلأِؼً لإِىخ١ٔخص حٌّششٚ, رمظذ طلم١ك أ٘ذحفٗ رىفخءس 

ِعااخ١٠ش حٌااضِٓ ، ٚحٌىٍفااش ، ٚحٌـااٛدس ، عٍااٝ أْ طؤخااز ٘اازٖ حلإدحسس حٌعٛحِااً ٚحٌّظر١ااشحص حٌز١ج١ااش حٌّخظٍفااش 

 حٌّل١طش رخٌّششٚ, .

ٟ٘ ططز١ك حٌّعشفش ٚحٌّٙاخسحص ٚحلأدٚحص ٚحلأعاخ١ٌذ عٍاٝ أٔشاطش  -أ٠ؼخ  : رؼشيف إداسح انًششٔع٠ّٚىٓ 

طلم١اك ادحسس حٌّشاشٚعخص عآ ؽش٠اك ططز١اك ع١ٍّاخص ادحسس حٌّششٚ, ٌظلم١اك ِظطٍزاخص حٌّشاشٚ, ، ٠ٚاظُ 

حٌّشااشٚعخص ٚطىخٍِٙااخ ِاآ حلارظااذحء ٚحٌظخطاا١ؾ ٚحٌظٕف١ااز ٚحٌّشحلزااش ٚحٌااظلىُ ٚأٙااخء حٌّشااشٚ, ، ٚأْ ِااذ٠ش 

 حٌّششٚ, ٘ٛ حٌشخض حٌّغئٚي عٓ طلم١ك أ٘ذحف حٌّششٚ, .

    -ٔرشزًم إداسح انًششٔع ػهٗ يب يهي  

 رخٌّششٚ, .طلذ٠ذ حٌّظطٍزخص حٌخخطش  -

 ٚػع أ٘ذحف ٚحػلش ٠ّٚىٓ طلم١مٙخ . -

 طٛحصْ ٚطلم١ك حٌّظطٍزخص حٌظٕخفغ١ش ٌٍـٛدس ٚحٌٕطخق ، ٚحٌٛلض ، ٚحٌظىٍفش . -

طى١١ااف حٌّٛحطاافخص ٚحٌخطااؾ ٚحلأعااخ١ٌذ ٔلااٛ حلا٘ظّخِااخص ٚحٌظٛلعااخص حٌّخظٍفااش ٌٍعذ٠ااذ ِاآ أطاالخد  -

 حٌّظٍلش فٟ حٌّششٚ, .

 

  انًكَٕبد انزي نٓب ػ قخ ثبنًششٔع 

 ِذ٠ش حٌّششٚ, .أٚلا  // 

 فش٠ك أٚ فشق حٌعًّ .ػخ١ٔخ  // 

 ٔظخَ ادحسس حٌّششٚ, .ػخٌؼخ  // 
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٠عظزش ِذ٠ش حٌّششٚ, حٌعٕظش حلأُ٘ لإدحسس حٌّششٚ, لأٔٗ حٌشخض حٌٛك١اذ حٌازٞ  -أٔلاً // يذيش انًششٔع  

طٛؿ١ااٗ حٌّشااخسوخص ٠ظّظااع رخٌّغاائ١ٌٚخص حٌّظعٍمااش رخطااش حٌّشااشٚ, ٚطٛؿ١ااٗ ؿٙااٛد حٌعّااً رخلإػااخفش اٌااٝ 

ٚحٌّلخدػااخص اٌااٝ طلم١ااك أ٘ااذحف حٌّشااشٚ, , ٚفااٟ حٌز١جااخص عااش٠عش حٌظر١ااش طظاازق ِاآ حٌظااعٛرش أْ طظعخِااً 

 -حٌّٕظّش ِع حٌلمخثك ِؼً حٌظىٌٕٛٛؿ١خ ٚحٌىٍف ٚحلأعٛحق , ٕٚ٘خٌه أٔٛح, عذ٠ذس ٌّذسحء حٌّششٚ, ِٕٙخ :

أٔـخص حٌّششٚ, ٚطمذ٠ُ حٌظمخس٠ش ٚخطٛحص ٘ٛ حٌزٞ ٠مَٛ رّظخرعش ِشحكً  -يذيش يزبثؼخ انًششٔع   - أ

حٌؼااشٚس٠ش اٌااٝ حلإدحسس حٌع١ٍااخ ٚطظشوااض ِّٙااش حٌّااذ٠ش فااٟ طلم١ااك حٌٛكااذس ِااخ راا١ٓ حٌّفٙااَٛ حٌفٕااٟ 

ٚحٌّفَٙٛ حٌظـخسٞ أٞ طل٠ًٛ حٌّفَٙٛ حٌفٕٟ اٌٝ ِفَٙٛ طـخسٞ ٌٍّششٚ, ِٓ ك١غ حٌظىٍفش ٚحٌـذٌٚش 

 أٚ حٌغٛق .

طظشوض ِٙخِٗ فٟ طلم١ك حٌٛكذس ر١ٓ حٌغ١طشس عٍٝ حٌفعخ١ٌخص لإٔـخص حٌّشاشٚ,  -يُغق انًششٔع   - ة

 ٚطٕغ١ك حلأعّخي ر١ّٕٙخ ِٓ خلاي حٌظلاك١خص حٌّخٌٛش ٌٗ .

٘ااٛ حٌّااذ٠ش حٌلم١مااٟ ٌٍّشااشٚ, ٠ٚىااْٛ ِغاائٚي عاآ وخفااش ِغااخكخص حٌٛظااخثف  -يااذيش انًشااشٔع   - د

حٌغخرم١ٓ ِٓ حٌّذسحء ٚطظشواض ِّٙظاٗ حلإدحس٠ش حٌّعشٚفش وّخ ٠ٚمَٛ رخٌٛظخثف حٌخخطش ر١ٓ حٌّٕط١ٓ 

 فٟ طلم١ك حٌٛكذس حلاطـخ٘خص ٚحٌفعخ١ٌخص حٌّخظٍفش ٌظلم١ك حٔـخص حٌّششٚ, ٚفك حٌخطش حٌعخِش ٌٗ .

٠ظىاْٛ فش٠اك حٌّشاشٚ, ِآ ِـّٛعاش ِآ حلأفاشحد أٚ حٌّـاخ١ِع حٌظاٟ  -أٔ انؼًام   ثبَ ب // فشياق انًشاشٔع

ٌفاشق حٌّٛكاذس ٠ٚعٍّاْٛ ؿّا١عُٙ عٍاٝ طٕف١از ٘اذف طعًّ عٍٝ طشاى١ً فش٠اك عّاً ٚحكاذ أٚ ِـّٛعاش ِآ ح

 ِشظشن ٚحكذ ِٚلذد .

لا رذ ِٓ ل١خَ ِذ٠ش حٌّششٚ, ٚفش٠اك عّاً حٌّشاشٚ, عٍاٝ حٌظٛحؿاذ ػآّ  -ثبنثبً // َظبو إداسح انًششٔع  

حٌٕظخَ أٞ ٔظخَ ادحسس حٌّششٚ, ٚحلأظفخ, ِٕٗ لأْ ٔظاخَ ادحسس حٌّشاشٚ, ِّؼاً رخ١ٌٙىاً حٌظٕظ١ّاٟ ِٕٚٙـ١اش 

حلاطظخي , وزٌه ٠ّؼً ع١ٍّش طذفك حٌّعٍِٛاخص ِٚعخٌـظٙاخ رخلإػاخفش اٌاٝ حٌظطز١ماخص ٚحلاعاخ١ٌذ حٌظاٟ لٕٛحص 

( ٠ّىآ طٛػا١ق عٕخطاش طىخِاً 1طلمك عٕخطش طىخِاً أفم١اخ  أٚ عّٛد٠اخ  ٌظٕظا١ُ حٌّشاشٚ, , ِٚآ حٌشاىً )

 -حٌّششٚ, :
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 (1انشكم )

 ًَٕرج رُظ ى انًششٔع

 

  ػُبطش انًششٔع 

رّخ أْ حٌّششٚ, عزخسس عٓ ِٕظؾ ٠ّظخص رخلأفشحد حلا أٔٗ ٠ّىٓ أْ رؤخز أشىخي ِظعاذدس ِؼاً رٕاخء ِاذْ ؿذ٠اذس 

أٚ رٕخء عفٓ ؿذ٠ذس طّؼً حٌشىً حٌّخدٞ حٌٍّّٛط فاٟ كا١ٓ أْ أعاذحد دسحعاش ؿاذٜٚ ٌّشاشٚ, ِعا١ٓ )أٞ أْ 

ٍّّاٛط ٌٍّشاشٚ, ِٚاخ را١ٓ دسحعش حٌـذٜٚ رلذ رحطٙخ طعظزش ِششٚ,( ك١غ طّؼً حٌشىً حٌّعٍِٛاخطٟ غ١اش حٌ

٘ز٠ٓ حٌشى١ٍٓ )حٌّاخدٞ, حٌّعٍِٛاخطٟ( , ٠ٛؿاذ حٌىؼ١اش ِآ حٌّٕظـاخص ٚحٌّخشؿاخص حٌّخظٍفاش حٌظاٟ طظطٍاذ واً 

  -ِٕٙخ ِظطٍزخص خخطش ٌٙخ , ِٚٓ أُ٘ حٌعٕخطش حٌّشظشوش ٌٍّششٚعخص ٟ٘ وخ٢طٟ :

 .ػشٚسس أعذحد حٌّٛحطفخص ٌٍّششٚ,  -1

 خطش حٌّششٚ, . -2

 حٌّٛحصٔش . -3

 ٟ لإٔـخص حٌّششٚ, .حٌغمف حٌضِٕ -4

 خطش طمذ٠شحص حٌىٍف . -5

 طلذ٠ذ ِئششحص حٌـٛدس حٌّطٍٛرش . -6
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 طلذ٠ذ حٌّغخكش حٌّظٛلعش فٟ كخٌش عذَ ح١ٌم١ٓ . -7

 طم١١ُ كـُ حٌخطش حٌّظٛلع ٚط١ٙجش حلاعظـخرش حٌّلاثّش ٌٗ . -8

 -ػبد إنٗ قغً ٍ ًْب  ششٔرقغى انً

ٟ٘ طٍه حٌّششٚعخص حٌظٟ ٠ـشٞ طٕف١از٘خ ػآّ ح١ٌٙىاً حٌظٕظ١ّاٟ ٌٍّٕظّاش  -يششٔػبد راد انؼٕائذ   -1

 ٚعخدس ِخ طٕفز فٟ دٚسس حٌعًّ حٌٛحكذ ٠ٚظُ حكظغخد وٍفٙخ ِشٖ ٚحكذس ػّٓ حٌّٛحصٔش .

ٟ٘ طٍه حٌّششٚعخص حٌظٟ لا طٕفاز ػآّ ح١ٌٙىاً حٌظٕظ١ّاٟ ٌٍّٕظّاش ٚحٌظاٟ  -انًششٔػبد انشأعًبن خ   -2

ِااآ دٚسس حٌعّاااً حٌٛحكااذس ٚدٚسس حٌّٛحصٔاااش حٌٛحكااذس , وّاااخ ٚأْ ٘ااازٖ  ِاآ حٌّّىااآ حْ طّظااذ اٌاااٝ أوؼااش

حٌّششٚعخص ٠ّىٓ أْ طىْٛ لطخ, خخص أٚ لطخ, عخَ أٚ ولاّ٘خ ِعخ  , ٚطّظخص حٌّششٚعخص حٌشأعّخ١ٌش 

  -رظفظ١ٓ ّ٘خ:

 طغظرشق حٌّششٚعخص حٌىز١شس فٟ ِعظُ حٌلخلاص اٌٝ حٌىؼ١ش ِٓ حٌضِٓ لإٔـخص٘خ . - أ

ٚرطز١عااش حٌلااخي أْ ِؼااً ٘اازٖ  .ّخي وز١اش لإٔـخص٘ااخ ّخ١ٌش دحثّااخ  اٌااٝ سأعااشٚعخص حٌشأعااحٌّشاا طلظاخؽ - د

حٌّششٚعخص لا طذخً ػّٓ ح١ٌٙىً حٌظٕظ١ّٟ حٌظم١ٍذٞ ٌٍّٕظّاش , حلا أٔٙاخ طمطاع حٌٛظاخثف حٌّظعاذدس 

  ِّخ ٠ـعٍٙخ رلخؿٗ اٌٝ ١٘ىً طٕظ١ّٟ خخص رٙخ .ٚحٌلذٚد حٌض١ِٕش رخٌّٕظّش 

 

  ث ئخ انًششٔع 

ف١ّخ ر١ٕٙخ ٚوزٌه ادحسس حٌّششٚ, ٚفمخ  اٌٝ خظخثض حٌز١جش حٌّل١طش ٠ّٚىٓ طمغ١ُ حٌز١جش طخظٍف حٌّششٚعخص 

 -حٌّل١طش اٌٝ عذس ألغخَ ٟٚ٘ :

 حٌز١جش حٌظـخس٠ش ٚطٙذف اٌٝ طلم١ك حٌشرق ٚحٌعٛحثذ . -1

 حٌز١جش حٌلى١ِٛش )حٌعخِش( طٙذف اٌٝ طمذ٠ُ ِشخس٠ع خذ١ِش ِخظٍفش غ١ش سرل١ش . -2

 ٌّظعٍمش رخٌّشخس٠ع حٌعغىش٠ش ٚحلأ١ِٕش .حٌز١جش رحص حٌطخرع حٌخخص ح -3

 

طٙذف ٘زٖ حٌز١جش عخدس اٌٝ طلم١ك حٌشرق أٞ ٠ىْٛ حٌّٕظؾ حٌٕٙخثٟ ِعاشف رظاٛسس  -أٔلاً // انج ئخ انزدبسيخ  

ٚحػلش ِٚفِٙٛش ٚغخٌزخ  ِخ ٠ىْٛ ِٛؿٗ ٌظٍز١ش كخؿخص ٚسغزخص حٌضراْٛ ِٕٚغاـّخ  ِاع حٌّظطٍزاخص حٌذحخ١ٍاش 

ٌّعااخ١٠ش حٌّغااظخذِش ٌٍّشااشٚعخص حٌظـخس٠ااش طّظااخص رااخٌظشو١ض حٌشااذ٠ذ عٍااٝ حٌااشرق ٌااٗ , ٚأْ حٌذحفع١ااش ٚٔـااخف ح

وّخ ٚأْ ِذ٠ش حٌّششٚ, عخدس ٠مٛد حٌّششٚ, ِٓ خلاي دٚسس حٌل١اخس ,  ٚحٌعٛحثذ حٌّشحد طلم١مٙخ فٟ حٌّششٚ,

ٚوزٌه حٌىخٍِش ٌٗ , رخلإػخفش اٌٝ أٔٗ ٠عًّ عٍٝ طٕغ١ك حٌـٙٛد )ؿٙٛد فش٠ك حٌعًّ( ِع حٌّغخؿخص حٌٛظ١ف١ش 

ٚحلاطظخي حٌّزخشش ؿٙٛد حٌّمخ١ٌٚٓ حٌؼخ١٠ٛٔٓ ٚحٌّٛسد٠ٓ , ٠ٚمَٛ ِذ٠ش حٌّششٚ, أ٠ؼخ  ربدحِش حٌعلالش حٌٛػ١مش 

ِع حٌضرْٛ ِآ ؿٙاش ٚطٛطا١ً حٌّعٍِٛاخص رحص حٌظاٍش رخٌّشاشٚ, اٌاٝ حلإدحسس حٌع١ٍاخ أٚي راؤٚي رخظاٛص 

ٚفاٟ حٌٛلاض حٌازٞ ٠ىاْٛ ف١اٗ حٌّشاشٚ, لاذ لم١مٗ ٌٍشرق ٚحٌعٛحثذ حٌّغاظٙذفش , طمذَ حٌعًّ رخٌّششٚ, ِٚذٜ ط
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, أٔـض ِٓ حٌّّىٓ أْ ٠ـشٞ طغش٠ق ِذ٠ش حٌّششٚ, ٚأعؼخء فشق حٌعًّ حٌزٞ عخّ٘ٛح فٟ أٔـخص حٌّششٚ, 

ألا أٔٗ فٟ حٌىؼ١ش ِٓ حٌلخلاص , ٔشٜ رؤْ ِاذسحء حٌّشاشٚعخص ٠غاظّشْٚ فاٟ أعّاخٌُٙ رعاذ أٔـاخص حٌّشاشٚ, 

حٌّٕـاض ٚرظ١ٙجاش ِظطٍزاخص حٌزاذء رّشاشٚ, آخاش ؿذ٠اذ ِؼاً  حٌّعٕٟ ك١غ ٠مِٛاْٛ رّظخرعاش طشار١ً حٌّشاشٚ,

   .   ش ِٕفشدٌٛٛؿ١خ حٌلذ٠ؼش أٚ أٔشخء ِششٚ, أخحٌظٛعع فٟ ادخخي حٌظىٕ

طّظخص رخٌّششٚعخص غ١ش حٌٙخدفاش ٌظلم١اك حٌاشرق ٚحٌعٛحثاذ رخعظزخس٘اخ ِٛؿاٗ اٌاٝ  -ثبَ بً // انج ئخ انسكٕي خ  

حٌظع١ّ١ٍاش ٚحٌّئعغاخص حٌظال١ش ٚحٌّٛحطالاص ٌازٌه طخظٍاف خذِش حٌّـظّع ِؼً رٕخء حٌّذسحط ٚحٌّئعغاخص 

 -حٌّششٚعخص حٌلى١ِٛش عٓ حٌّششٚعخص حٌظـخس٠ش رعذس ؽشق ِٕٙخ :

عذَ ٚؿٛد ِلفضحص ِخ١ٌش ِؼً حٌشرق فٟ حٌّششٚعخص حٌلى١ِٛش ٚحٌّششٚعخص غ١ش حٌشرل١ش رخلإػاخفش  -1

ٌّششٚ, , ٚغخٌزخ  ِخ ٠ـشٞ فاٟ حٌز١جاش لإدحسس ح اٌٝ حْ حٌعٛحًِ حلالظظخد٠ش طّظخص رخلأ١ّ٘ش حلألً رخٌٕغزش

ِٓ أعخدس طع١١ٓ ِذ٠ش حٌّششٚ, خلاي طٕف١ز حٌّششٚ, ِّاخ ٠ائدٞ اٌاٝ كاذٚع حٌلى١ِٛش ٚغ١ش حٌشرل١ش 

 حٌّشىلاص حلإدحس٠ش ِٓ ؿشحء رٌه .

طشوض ِعظُ حٌّششٚعخص عٍٝ طم٠ُٛ أٚ حخظزخس حٌّٕظـخص ٚحٌخذِخص لاْ ؿ١ّع حٌّٛحصٔخص ِٛؿٙش ٔلٛ  -2

 ٚحٌخذِخص حٌّشحد طط٠ٛش٘خ ِٓ لزً حٌّٛسد .طض٠ٚذ حٌّٕظـخص 

٘زٖ حٌز١جش )حٌعغىش٠ش ٚحلأ١ِٕش( ِع حٌز١جش حٌلى١ِٛش لاْ ِعظُ حٌّششٚعخص طظشخرٗ  -ثبنثبً // انج ئخ انخبطخ  

حٌعغىش٠ش ٚحلأ١ِٕش طلظاٛٞ عٍاٝ حلأؿٙاضس ٚحٌّعاذحص حٌّغاظخذِش فاٟ فلاض ٚطم١ا١ُ حٌّشاشٚ, ٚحٌظاٟ طىاْٛ 

ٍِّٛوش ِٓ لزً حٌّمخٌْٚٛ حٌؼخ٠ْٛٔٛ ٚطعظّاذ ع١ٍّاش حٌظم١ا١ُ ٘ازٖ عٍاٝ ٔظاخَ ٠غاّٝ رٕظاخَ )أٔظّاش حلاعاٍلش( 

حٌظاٟ طغاخُ٘ فاٟ  ٚحٌّعاذحص ْ ٠ىاْٛ حٌّشاشٚ, حٌٛحكاذ ؿاضء ِآ رشٔاخِؾ ٚحعاع ِآ حلأٔظّاشراؤٟ طعٕٟ ٚحٌظ

, ٚطىاْٛ حلأ١ّ٘اش حٌشث١غا١ش ٌظم١ا١ُ حٌّشاشٚعخص فاٟ ِؼاً ٘ازٖ حٌز١جاش اٌاٝ  حٌٕظخَ حٌشخًِ )حٌّششٚ, حٌشاخًِ(

وّاخ ٚأْ ِؼاً ٘ازٖ ىٍاف , ك١غ طٌٛٝ حلأ١ّ٘ش حلألً ٌٍّعاخ١٠ش حلالظظاخد٠ش ٚحٌ , حٌعٛحًِ حٌغ١خع١ش ٚحٌف١ٕش فمؾ

حٌّشاااشٚعخص لا طٙاااذف اٌاااٝ طلم١اااك أٞ ٔاااٛ, ِااآ حٌاااشرق أٚ حٌعٛحثاااذ حٌّخ١ٌاااش , ٚغخٌزاااخ  ِاااخ ٠ىٛٔاااٛح ِاااذسحء 

حٌّشاشٚعخص ِاآ حٌؼاازخؽ حٌعغااىش١٠ٓ ِّااخ ٠ظطٍااذ ِإُٙ حٌلظااٛي عٍااٝ حٌّٙااخسحص حلإدحس٠ااش ٚحٌف١ٕااش لإدحسس 

  . حٌّششٚعخص ِٓ خلاي طىؼ١ف حٌزشحِؾ حٌظذس٠ز١ش ٚحٌظط٠ٛش٠ش ٌُٙ

 

 أْذاف انًششٔع 

   أْذاف تبطخ، أْذاف ػبيخ، أْذاف فشػ خ يًكٍ أٌ َقغى أْذاف انًششٔع إنٗ

طفظشع حٌٕظش٠ش حلالظظخد٠ش ٌٍّششٚ, أْ طلم١ك ألظاٝ سراق ٠عظزاش ِآ حلأ٘اذحف  الأْذاف انخبطخ   -1

 حٌشث١غ١ش لأٞ ِششٚ,، ٚحٌشرق حٌزٞ ٠غعٝ ا١ٌٗ حٌّشاشٚ, ٘اٛ حٌفاشق را١ٓ كظا١ٍش حٌّز١عاخص ٚطىاخ١ٌف

ٌٚىٓ عٍٝ حٌشغُ  حلإٔظخؽ، ٠ٚظذسؽ فٟ طىخ١ٌف حلإٔظخؽ رٙزح حٌّفَٙٛ وً حٌٕفمخص حٌظٟ ٠ظلٍّٙخ حٌّششٚ,.
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حٌٛك١ااذ  الا أٔااٗ لا ٠عظزااش حٌٙااذف طلم١ااك حٌااشرق ٠عظزااش ػااشٚسٞ لاعااظّشحس حٌّشااشٚ, ّٚٔااٖٛ،ِاآ أْ 

 -فزـخٔذ طلم١ك حلأسرخف ٔـذ أ٘ذحف أخشٜ وؼ١شس ِٚٓ أّ٘ٙخ :

شاٙشس ٚحعاعش ٚػماش وز١اشس  ٍاٝ, عطلم١ك ألظٝ لذس ِّىٓ ِٓ حٌّز١عخص وٛع١ٍش ٌلظاٛي حٌّشاشٚ - أ

 .حلأعٛحق فٟ

حلاعظؼّخس ٞ ٌّششٚ, لخثُ ٘ٛ كّخ٠ش حٌٕشخؽ حٌشث١غٟ ِٓ خطش طٛلف لذ ٠ىْٛ حٌٙذف ِٓ حلإٔفخق  - ة

 حلإٔظخؽ.

اْ طلم١ك حٌّٕفعش حٌعخِش ٘ٛ حٌٙذف حلأعخعٟ ٌٍّشاشٚ, حٌعاخَ عاٛحء طلماك سراق ِآ  الأْذاف انؼبيخ   -2

فعش حٌعخِش لذ طىْٛ فٟ ر١ع عٍعش أٚ طمذ٠ُ خذِش رغاعش طىٍفظٙاخ أٚ ٘زح حٌّششٚ, أٚ ٌُ ٠ظلمك، فخٌّٕل١خَ 

ٌٚىٓ ٠ـذ أْ لا ٠فُٙ ِٓ رٌه أْ حٌّششٚعخص حٌعخِش لا طٙظُ اؽلالخ رخٌشرق رً ٠ـذ ألا ٠اظُ رٌاه  لًرؤ

 -: كغخد طلم١ك حلأ٘ذحف حٌظٟ أٔشت حٌّششٚ, حٌعخَ ِٓ أؿٍٙخ ٚ٘زٖ حلأ٘ذحف ٟ٘ عٍٝ

 طمذ٠ُ خذِش - أ

 حٌشرق  - د

 حلا٘ذحف حلاؿظّخع١ش - ص

 حٌّٕٛ - ع

 رضِٓ ِع١ٓ ٌظٕف١ز٘خ، ٠ٚلاف ظ أْ حلأ٘ذحف حٌغخرمش٠ٚـذ أْ طىْٛ ٘زٖ حلأ٘ذحف حٌغخرمش و١ّش ِٚلذدس 

 ِظىخٍِش ِع رعؼٙخ حٌزعغ، فّؼلا لا رذ أْ طظلمك أ٘ذحف حٌخذِش كظٝ ٠ّىٓ طلم١ك حلأسرخف ، ٚأ٠ؼخ لا رذ

 ِٓ طلم١ك أ٘ذحف حٌشرل١ش كظٝ ٔغظط١ع طلم١ك حلأ٘ذحف حلاؿظّخع١ش، ٚأخ١شح ٠عظّذ ٘ذف حٌّٕٛ عٍٝ ِذٜ

 -: ٠ٚٛػق حٌشىً  طىخًِ ٘زٖ حلأ٘ذحف ٚطشط١زٙخ،  ٌخذِش ٚحٌشرل١شحٌٕـخف فٟ طلم١ك أ٘ذحف ح

 ركبيم أْذاف انًششٔع

اْ حٌٙااذف حلأعخعااٟ لأٞ ِشااشٚ, ٘ااٛ طمااذ٠ُ خذِااش ِف١ااذس ٌٍّـظّااع ٚرٌااه ِاآ ْااذف انخذيااخ    - د

 .خلاي أظخؽ ٚطٛص٠ع حٌغٍع ٚحٌخذِخص أٚ طلم١ك حلإشزخعخص حٌّطٍٛرش ٌٍّـظّع
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٠مظااذ رٙااذف حٌشرل١ااش، طلم١ااك سرااق ٌظااخكذ حٌّشااشٚ, ك١ااغ أْ حٌّشااشٚ,  ْااذف انشثس ااخ   - س

حٌخااخص طلشوااٗ حٌشرل١ااش ٌٍااذخٛي فااٟ ِـااخي ِعاا١ٓ، ٚرٌااه لأْ حٌااشرق ٘ااٛ عزااخسس عاآ ِىخفااؤس 

 خخؽش رؤِٛحٌٗ ٚطلًّ ِخخؽشس حلاعظؼّخس فٟ ٘زح حٌّـخي. ٌظخكذ حٌّششٚ, لأٔٗ

جااخص أخااشٜ فااٟ حٌّـظّااع ك١ااغ أْ ٕ٘ااخن ف ٌٍّشااشٚ, ٘ااذف حؿظّااخعٟ، انٓااذف الاخزًاابػي   - ج

رخالاف حٌّغااظٍٙى١ٓ وخٌعاخ١ٍِٓ، ٚحٌّااٛسد٠ٓ ،ٚحٌلىِٛااش، ٚحٌّـظّاع حٌّمااخَ راٗ حٌّشااشٚ, ٔفغااٗ 

ٚعٍٝ ٘زح فعٍٝ طخكذ حٌّششٚ, أْ ٠لّٟ ِظخٌق وً ٘ئلاء ٠ٚٙظُ  حٌّششٚ,، ٠ظؤػشْٚ رٙزح

 حلأسرخف . رُٙ وّخ ٠ٙظُ رظلم١ك

١اغ ٌآ ٠ؼاً حٌّشاشٚ, طار١شح ؽ١ٍاش ذ أْ ٠ٙظُ حٌّششٚ, رؤ٘ذحف حٌّٕاٛ رل٠ـْذف انًُٕ    - ذ

 لا رذ أْ ٠ّٕٛ ٠ٚىزش رخٌظذسؽ. رًك١خطٗ، 

ٙخ طاخكذ حٌّشاشٚ, ٌسلغاخَ حلأ٘اذحف حٌظاٟ ع١ؼاع ٠مظذ رخلأ٘ذحف حٌفشع١اش،   الأْذاف ان شػ خ -3

ء حلأ٘اذحف فاٟ ػاًٛ ٚحٌزلٛع ٚ حلأفشحد ( ٚرٌاه ٠شٚعٗ )وخلإٔظخؽ ٚحٌظغ٠ٛك، ٚحٌظٌّّٛش حٌفشع١ش

ٌٍّششٚ, ك١غ أْ ٘زح ٠غخعذ فٟ طٛؿ١ٗ حلأدحء دحخاً ٘ازٖ حلألغاخَ ، ٌىآ ٠لاكاع أْ  حٌعخِش حٌغخرمش

طظعاخسع ِاع رعؼاٙخ حٌازعغ دحخاً واً لغاُ ٚف١ّاخ را١ٓ حلألغاخَ حٌفشع١اش،  ٘زٖ حلأ٘ذحف وؼ١اشح ِاخ

 .حٌظعخسع رمذس حلإِىخْ كظٝ لا ٠ئػش ٘زح عٍٝ حٌّششٚ, وىً ٚعٍٝ ٘زح لارذ ِٓ طم١ًٍ ٘زح

 يشازم انًششٔع 

ؿ١ّع حٌّششٚعخص رؤسرعاش ِشحكاً ٚ٘ازٖ حٌّشحكاً فاٟ رعاغ حلأك١اخْ ٠ّىآ أْ طاضدحد أٚ طماً رلغاذ طّش 

 -كـُ ّٚٔؾ حٌّششٚ, , ٚحٌّشحكً حٌظٟ ٠ّش رٙخ حٌّششٚ, وخ٢طٟ :

طعظزش ٘زٖ حٌّشكٍش ٟ٘ ِشكٍش كخعّش ِّٚٙاش فاٟ ك١اخس حٌّشاشٚ, , ك١اغ  -يشزهخ انزقذيى ٔانزؼشيف   -1

ٚحٌمؼخ٠خ حٌّظعٍمش رخٌّشاشٚ, , ٚطظٌٛاذ حٌفىاشس حلأ١ٌٚاش ِآ ػاشٚسس ل١اخَ  ِٛس ٚحٌمشحسحصطظزعٙخ وخفش حلأ

لألخِظاٗ , ِٚؼاً  اٌٝ حٌّٕظّش ٌٍلظاٛي عٍاٝ حٌّٛحفماش حٌّششٚ, ِٚزشسحص حٌلخؿش أ١ٌٗ ٚحٌظٟ طمذَ عخدس

١ٓ أٞ ِآ أكاذ حٌضراخثٓ حلأعخعا١ ٘زٖ حلأفىخس ٠ّىٓ أْ طؤطٟ ِٓ حٌفشد حٌعخًِ رخٌّٕظّش أٚ ِٓ خخسؿٙاخ ,

ؿذ٠ذ عٍٝ عز١ً حٌّؼخي ٠مع ػّٓ اِىخ١ٔخص حٌّٕظّش حلالظظخد٠ش رؤْ ِششٚ, ِٕظؾ , ٌٕٚفظشع ش ٌٍّٕظّ

عٕذثز ٚلزً واً شاٟء , أٞ لزاً أطخاخر أٞ لاشحس رمزاٛي أٚ سفاغ حٌّشاشٚ, , لاراذ ِآ أؿاشحء ٚحٌف١ٕش , 

ٌخزااشس دسحعااش حٌـااذٜٚ حٌف١ٕااش ٚحلالظظااخد٠ش حٌظفظاا١ٍ١ش , ٚ٘اازح ٠ظطٍااذ حخظ١ااخس حٌّااذ٠ش حٌمااذ٠ش ِاآ رٚٞ ح

رخلإػخفش اٌاٝ طلذ٠اذ ؿ١ّاع حٌٛظاخثف رحص حٌظاٍش رخٌّشاشٚ, رّاخ فاٟ ٚحٌذسح٠ش حٌىخف١ش لإدحسس حٌّششٚ, 

٠ٚظٛؿذ فٟ ٘زٖ حٌّشكٍاش رٌه حٌّٛسد٠ٓ حٌخخسؿ١١ٓ ٚحٌّمخ١ٌٚٓ حٌؼخ١٠ٛٔٓ ٌٍعًّ عٍٝ أٔـخص حٌّششٚ, . 

ٌخشحثؾ ٚحٌشعِٛخص حْ طلظٛٞ ٚػخثك حٌّششٚ, عٍٝ طعش٠ف حٌّششٚ, ٚحٌٙذف ِٕٗ ٚوزٌه حٌظظ١ُّ ٚح

حٌّظعٍمش رٗ رخلإػخفش اٌٝ ِئششحطٗ حٌّخظٍفش ك١غ طىْٛ ِٛػمٗ رظٛسس ٚحػلش ِٚظفك ع١ٍٙخ ِع حلأ١ٌٚش 
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أؽشحف حٌّششٚ, ٚخخطش أطلخد حٌّظخٌق ٚحٌّغظف١ذ٠ٓ ِٕٗ , ٚرعذ حٌّظاخدلش عٍاٝ حٌّشكٍاش حلأٌٚاٝ 

 رّشكٍش حٌظل١ًٍ ٚحٌظظ١ُّ . طزذأ حٌّشكٍش حٌؼخ١ٔش ٟٚ٘ ِشكٍش طط٠ٛش حٌّششٚ, أٚ ِخ طغّٝ أك١خٔخ  

فٟ ٘زٖ حٌّشكٍش ٔفظشع رؤْ حٌّششٚ, حٌـذ٠ذ حٌّمظشف لاذ طّاض حٌّٛحفماش  -  ٔانزظً ىزنٕيش انيشزهخ  -2

, رعذ رٌه ٠ـشٞ حٌم١خَ ربعذحد طظخ١ُِ حٌّششٚ, حٌظفظ١ٍ١ش رخٌّغظٜٛ حٌّطٍٛد ٚرّاخ ٠ىفاٟ ٌظ١ٌٛاذ ع١ٍٗ 

, ٚلاراذ أ٠ؼاخ  اعطاخء ٔغاخش ِآ  انزقاذيى ٔانزؼشياف( )يشزهخحٌلذٚد حٌظٟ طُ طلذ٠ذ٘خ رخٌّشكٍش حلأٌٚٝ 

دسحعش حٌّششٚ, اٌٝ حٌّغئ١ٌٚٓ ِٓ حلأعؼخء حٌشث١غ١١ٓ فٟ فاشق عّاً حٌّشاشٚ, , وّاخ ٠ظطٍاذ وازٌه 

فٟ ٘زٖ حٌّشكٍش طط٠ٛش حٌخطش حٌشث١غ١ش ٌٍّششٚ, طلض حلأششحف حٌّزخشاش ٌّاذ٠ش حٌّشاشٚ, رخعظزخس٘اخ 

 -ٙذف ِشكٍش حٌظط٠ٛش اٌٝ طلم١ك ٘ذف١ٓ ّ٘خ :حٌٛػ١مش حٌشث١غ١ش فٟ ٍِف حٌّششٚ, , ٚط

 طلذ٠ذ ٚطمذ٠ُ ِظطٍزخص حٌّششٚ, حٌظفظ١ٍ١ش . - أ

 ٚػع حٌّٛحطفخص حٌظفظ١ٍ١ش ِٚظطٍزخص حٌظ١ٙجش حٌّطٍٛرش ٌخطش حٌّششٚ, . - د

ٚكخؿخطاٗ ِآ حٌّشاشٚ, لاْ كخؿاخص حٌّغاظف١ذ ِٚٓ خلاي ٘زٖ حٌّشكٍش ٠ّىٓ طلذ٠ذ ِظطٍزاخص حٌّغاظف١ذ 

طعظزش حٌّعخ١٠ش حٌظٟ طغظخذَ فٟ طلذ٠ذ لزٛي أٚ سفغ ٔظخثؾ حٌٕظاخَ حٌّغاظخذَ  ِٚظطٍزخطٗ ِٓ حٌّششٚ, ,

, لأٔٗ غخٌزخ  ِخ ٠لذع عٛء حٌفُٙ حٌىخًِ ٌلخؿخص ِٚظطٍزاخص أطالخد  ٍّششٚ,ٌفٟ كً ٚطل١ًٍ حٌّغؤٌش 

حٌّظخٌق ٚحٌّغظف١ذ ِٓ حٌّششٚ, ِّخ ٠ئدٞ اٌٝ كذٚع ِشخوً ٚطاشحعخص را١ٓ ادحسس حٌّشاشٚ, ٚرا١ٓ 

 أطلخد حٌّظخٌق ٚحٌّغظف١ذ حٌظٟ لذ طظً اٌٝ لؼخ٠خ طٕظٟٙ رخٌمؼخء . 

رمظ١ٓ ٠زماٝ عٍاٝ فش٠اك عّاً حٌّشاشٚ, ِآ حٌشاشٚ, رعذ حلأظٙخء ِٓ حٌّاشكٍظ١ٓ حٌغاخ -  انزُ  ز يشزهخ -3

رظٕف١ز حٌّشكٍش حٌؼخٌؼش , وّخ ٠ٚمَٛ سثا١ظ حٌفش٠اك رظماذ٠ُ حٌظماخس٠ش حٌؼاشٚس٠ش كاٛي طماذَ حٌّشاشٚ, اٌاٝ 

  -حلإدحسس حٌع١ٍخ ٚوزٌه اٌٝ أطلخد حٌّظٍلش ٚحٌّغظف١ذ ِٓ حٌّششٚ, ك١غ طظشوض عٍٝ :

 طمذَ حٌعًّ رخٌّششٚ, . -

 حٌٕفمخص . -

 حٌىٍف . -

 كذحع حٌظٟ ٌُ طىٓ ػّٓ حٌخطش .حلا -

ٚحٌفعخ١ٌخص حلأعخع١ش ٟٚ٘ أعذحد حٌظظخ١ُِ حٌظفظ١ٍ١ش ٌٍّششٚ, ٚططا٠ٛش  حٌخطٛحصٚطشًّ ٘زٖ حٌّشكٍش 

ٚحٌّظطٍزخص حٌّخد٠اش ٌّشكٍاش حٌظٕف١از ٚأٔظّاش حٌظض٠ٚاذ خطؾ حٌعًّ ٚؿذٌٚش حلأعّخي ٚوزٌه ششحء حٌّٛحد 

 -: ٚح٢ْ ٠ّىٓ ششف ٘زٖ حٌخطٛحص رخخظظخس حٌّظعٍمش رزٌهحٌّّىٓ أطزخعٙخ ٚحٌزٕخء ٚطٕف١ز وً حٌفمشحص 

٠ـاااشٞ خااالاي خطاااٛس حٌظظااا١ُّ رظل٠ٛاااً حٌّٛحطااافخص اٌاااٝ خطاااؾ ّٚٔاااخرؽ ِظااارشٖ  -انزظاااً ى   - أ

حلا ٚسعِٛخص ٚطخظٍف ِخشؿخص حٌظظ١ُّ ِٓ طٕخعش لأخاشٜ ٚفماخ  لأّٔاخؽ حٌٕظاخَ أٚ حٌّشاشٚ, , 

ٚحٌّخططااخص حلأغاا١خر١ش أٚ حٌّخططااخص أٔٙااخ طشااظشن فااٟ ع١ٍّااش حٌظمااذ٠ُ ٚرٌااه رخعااظخذحَ حٌّٕااخرؽ 
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ٚحٌشعَٛ حٌظخط١ط١ش حٌظٟ طظٙاش حٌّظٙاش ٚحٌشاىً حٌخاخسؿٟ ٌٍّشاشٚ, ٚطفخطا١ٍٗ , ٌازح فاؤْ ع١ٍّاش 

ط١ٙجش حٌظظ١ُّ حٌزٞ ٠عشع ِىٛٔخص حٌّشاشٚ, ٚحٌعلالاخص  )الأٔنٗ(حٌظظ١ُّ طلظٛٞ عٍٝ فعخ١ٌظ١ٓ 

فٙاٟ ط١ٙجاش حٌظظا١ُّ  )انثبَ اخ(عخ١ٌش حٌؼشٚس٠ش حٌظٟ طئدٞ اٌٝ طلم١ك حٌٙذف ِٓ حٌّششٚ, , أِخ حٌف

 حٌزٞ عٛف ٠عشع حٌشىً حٌّخدٞ حٌفعٍٟ ٌٍّششٚ, .

ٚواازٌه ِغااظٜٛ فعخ١ٌااش ٠ااضدحد كـااُ فش٠ااك حٌّشااشٚ,  -دٔس يااذيش انًشااشٔع فااي فؼبن ااخ انزظااً ى   - ة

, ِٚآ ٕ٘اخ ٠ماَٛ ِاذ٠ش فٟ ِشكٍش حٌظٕف١از ِآ حٌّشاشٚ, حٌّششٚ, رظٛسس ِغظّشس وٍّخ طمذَ حٌعًّ 

 رظلذ٠ذ ٚطٛص٠ع حٌٛظخثف عٍٝ سإعخء فشق حٌعًّ فٟ طٕظ١ّخص حٌّششٚ, ٚأؿضحءٖ .حٌّششٚ, 

٠ـاشٞ خاالاي فعخ١ٌاش حٌظظا١ُّ ِشحؿعااش حٌفماشحص ٚحلأِااٛس حٌظاٟ طعظزااش  -ي ى  بانغا نشح ػهاٗ انزظاا - د

حٌّفظاااخف حٌشث١غاااٟ رٙاااذف حٌظلماااك ِااآ أْ حٌظظاااخ١ُِ لاااذ طؼااإّض ؿ١ّاااع حلأ٘اااذحف ٚحٌّظطٍزاااخص 

ّشااشٚ, , ٚرٙاازح ٠مااَٛ ِااذ٠ش حٌّشااشٚ, أ٠ؼااخ  ِاآ ِشحؿعااش حٌخطااؾ ٚحٌّٛحطاافخص حٌّلااذدس رخطااش حٌ

ٚحٌـذحٚي ِٚٛحل١ض حٌظٕف١از ِٚظطٍزاخص حلأؽاشحف حٌّشاخسوش فاٟ حٌّشاشٚ, , وّاخ ٠ظٛؿاذ حٌلظاٛي 

عٍااٝ ِظااخدلش حٌّغااظف١ذ عٍااٝ حٌظظااخ١ُِ حٌٛظ١ف١ااش ٚحٌظفظاا١ٍ١ش رٙااذف حٌظؤوااذ ِاآ ؿ١ّااع حٌٛظااخثف 

 عٍِٛخص ٚغ١ش٘خ ٌظٍز١ش ِظطٍزخص حٌّغظف١ذ .حلأعّخي ٚحٌّٚحٌعلالخص ٚحٌظذفمخص أٞ طذفك 

٠زذأ ِذ٠ش حٌّششٚ, )أٚ ِٕغاك حلإٔظاخؽ( خالاي ِشكٍاش حٌظظا١ُّ ِآ  -انزخن ؾ نزشغ م انًششٔع   - س

اعااذحد حٌخطااش حٌّظعٍمااش رّشكٍااش طشاار١ً حٌّشااشٚ, رعااذ أٔـااخصٖ , ٠ٚمااَٛ رظـضثظٙااخ اٌااٝ ٚظااخثف ِؼااً 

طظ١ُّ حٌعاذد ٚحلأدٚحص ٚحٌّخو١ٕاخص حٌعّاً عٍاٝ طٕف١از ع١ٍّاش شاشحإ٘خ رخلإػاخفش اٌاٝ شاشحء حٌّاٛحد 

أٚ حلإٔظخؽ أْ وخْ حٌّشاشٚ, أظخؿ١اخ  , ٠ٚماَٛ أ٠ؼاخ  شر١ً حٌّششٚ, حلأ١ٌٚش ٚحٌخخِخص حٌؼشٚس٠ش ٌظ

ِذ٠ش حٌّششٚ, أٚ حٌّٕغك رع١ٍّش ششحء وخفاش حلأؿٙاضس ٚحٌّعاذحص ٚحٌّاٛحد حلاكظ١خؽ١اش ٚغ١ش٘اخ ِآ 

 ِغظٍضِخص حٌظشر١ً ٚحلإٔظخؽ .

طؤعاا١ظ  عٕااذ أـااخص حٌّشكٍااش حٌشحرعااش حٌظااٟ طّؼااً ِشكٍااش حلأظٙااخء ِاآ -يشزهااخ الاَزٓاابل ٔانزشااغ م   -4

 -حٌّششٚ, , ِٚٓ حٌّّىٓ أْ طظٙش حٌلخٌظ١ٓ حٌظخ١ٌظ١ٓ :

 حلأظٙخء حٌىخًِ ِٓ حٌّششٚ, ٚحٌلظٛي عٍٝ ِظخدلش حٌّغظف١ذ ِٓ حٌّششٚ, . - أ

حٌزااذء فااٟ ِشكٍااش أخااشٜ أٚ حلاعااظّشحس ِاآ حٌـااضء ح٢خااش ِاآ حٌّشكٍااش حٌشحرعااش حلا ٚ٘ااٛ طشاار١ً  - ة

 حٌّششٚ, .

ٛٞ عٍااٝ ل١ااخَ حٌّغااظف١ذ رظشاار١ً حٌّشااشٚ, ٔفغااٗ أٚ طااذخً طلظاا ٚ٘اازح ٠عظّااذ عٍااٝ خطااش حٌّشااشٚ, حرح وخٔااض

ِشكٍش حٌظشر١ً ػّٓ عمذ حٌّمخٌٚش ٚرٙزح طىْٛ ِغئ١ٌٚش ادحسس حٌّششٚ, طشر١ٍٗ , ٚطلظٛٞ ِشكٍش حلأظٙخء 

ِٓ حٌّششٚ, عٍٝ ع١ٍّش طل١ًٍ طمخس٠ش أـخص حٌّششٚ, حٌر١ٕش رخٌّعٍِٛخص حٌٛف١شس ٚحٌّف١اذس ؿاذح  ٚحٌظاٟ ِآ 

  -خ فٟ رٕخء ِششٚ, آخش . ٚطلظٛٞ ٘زٖ حٌظمخس٠ش عٍٝ ِخ ٠ٍٟ :حٌّّىٓ حعظخذحِٙ
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 ٔـخف حٌطشق ٚحلاعخ١ٌذ حٌظٟ طغظخذَ فٟ أٔشخء حٌّششٚ, . - أ

 ادحء حٌعخ١ٍِٓ فٟ فشق حٌعًّ . - ة

 حعظّخد٠ش حٌّٛسد٠ٓ . - د

 -ٌزح ٠ّىٓ طٛػق ِشحكً حٌّششٚ, حلاسرعش ٚٚظخثفٙخ ِٓ خلاي حٌشىً حٌظخ١ٌش :

 انًشزهخ انشاثؼخ انًشزهخ انثبنثخ  انًشزهخ انثبَ خ  انًشزهخ الأٔنٗ 

  يشزهخ انزقذيى ٔانزؼشيف -

رؼشيف انًششٔع , دساعخ  

اندذٖٔ ان ُ خ ٔالاقزظبديخ 

, انز بٔع يغ انًقبٔن ٍ 

انثبَٕي ٍ , رٓ ئخ 

 انًغزهضيبد انؼشٔسيخ .

 يشزهخ انزنٕيش ٔانزظً ى  -

 ٔػغ انخنخ ٔاندذٔنخ

نه ؼبن بد انشئ غ خ نهًششٔع 

, رسذيذ انًزنهجبد 

ٔانًٕاط بد , ٔانزظبي ى 

انشئ غ خ , ٔزغبثبد انًٕاسد 

 .  الأتشٖ

 يشزهخ انزُ  ز -

إػذاد انزظبي ى ٔانخشائؾ 

ٔانشعٕيبد , رُ  ز 

ان ؼبن بد , رقبسيش رقذو 

انؼًم , انُ قبد ٔانكهف 

 ٔانًٕاصَخ .

 يشزهخ الاَزٓبل ٔانزشغ م -

ٔع ٔاعز يّ َٓبيخ انًشش

, رشغ م انًششٔع , رسه م 

رقبسيش الإَدبص ٔرق  ى 

 الإدال  ٔاندٕدح ٔغ شْب .  

 

  الأعجبة الاعبع خ ن شم انًششٔع 

 -ٕ٘خٌه عذس أعزخد ٌفشً حٌّششٚ, أّ٘ٙخ :

 لا طٛؿذ دسحعش ؿ١ذس ٚوخف١ش ٌٍّششٚ, . -1

 عذَ طلذ٠ذ حٌّغئ١ٌٚخص ٚحٌّٙخَ ٌىً فشد ِٓ أفشحد حٌّششٚ, . -2

 خطش حٌّششٚ, ٌٍظفخط١ً .حفظمخس  -3

 حعظشحط١ـ١ش خخؽجش لاطخخر حٌمشحسحص حٌّظعٍمش رخٌّششٚ, . -4

 ١ِضح١ٔش أٚ ِٛحسد لا ٠ّىٓ حلاعظّخد ع١ٍٙخ . -5

 ٔمض فٟ حٌظٛحطً ٚحلارظعخد عٓ حٌٙذف حلاعخعٟ ٌٍّششٚ, . -6

 عذَ ِظخرعش حٌّششٚ, ٚفك حٌخطش حٌّٛػٛعش . -7

 

  إَٔاع انًشبسيغ 

 -أٔٛح, ِٕٙخ :٠ّىٓ طمغ١ُ حٌّششٚ, اٌٝ عذس 

ٚ٘ااٟ حٌّشااخس٠ع حلأوؼااش شاا١ٛعخ  فااٟ حٌٛحلااع حٌعٍّااٟ , ٚطظّؼااً فااٟ ِشااشٚعخص  -انًشاابسيغ الإَشاابئ خ   -1

حٌظش١١ذ ٚحٌزٕخء , ِؼً رٕخء حٌعّخسحص حٌغى١ٕش , ٚرٕخء حٌطشق ٚحٌـغٛس ٚرٕخء حٌّغظشف١خص , ٚوازٌه رٕاخء 

 حٌمٛحعذ ٚحٌّشطىضحص حلأعخع١ش ٌىخفش حٌّشخس٠ع حلأخشٜ .
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ٟٚ٘ حٌّشخس٠ع رحص حٌطخرع حٌظىٌٕٛٛؿٟ ٚحٌٕٙذعٟ حٌظٟ طٙذف اٌاٝ طٙاذف اٌاٝ  -انًشبسيغ انظُبػ خ   -2

 الخِش حٌّظخٔع ٚخطٛؽ حلإٔظخؽ ٚرٕخء حٌطخثشحص , طٕخعش حٌغ١خسحص ...حٌه .

 ِؼً حٌّشخس٠ع حٌظع١ّ١ٍش ٚحٌفٕذل١ش ٚأظخؽ حلافلاَ حٌغ١ّٕخث١ش . -انًشبسيغ انخذي خ   -3

ٟٚ٘ حٌّشخس٠ع رحص حٌطخرع حٌعٍّٟ ِؼً طظ١ُّ ٔظخَ ِع١ٓ ٚحٌظٕم١ذ عٓ حلاػاخس ,  -انًشبسيغ انؼهً خ   -4

 رلٛع حٌفؼخء .

ِؼً حٌّشخس٠ع حٌخخطاش رّىخفلاش حٌفغاخد , ِٚشاخس٠ع طٕظا١ُ حلأعاشس ٚحٌظٛع١اش  -انًشبسيغ الاخزًبػ خ   -5

 ػذ حٌظذخ١ٓ .

ش ٚحٌزطخٌش , ٚحٌظؼخُ ِٚشخس٠ع ِؼً حٌّشخس٠ع حٌّظعٍمش رّٛحؿٙش حٌىغخد ٚحٌفم -انًشبسيغ الاقزظبديخ   -6

 حٌخظخظش .

 

 رخن ؾ انًششٔع 

حٌظخط١ؾ ٘ٛ أٚي حٌٛظخثف حلإدحس٠ش ٚأّ٘ٙخ ، ٚطشطىض ع١ٍٗ رخلٟ حٌٛظخثف حلإدحس٠ش حلأخشٜ ِٓ طٕظ١ُ 

 ٚطٛؿ١ٗ ٚسلخرش .

أْ حٌظخط١ؾ ٠غزك أٞ عًّ طٕف١زٞ ٠ٚلذد حلأعّخي حٌظٟ ٠ـذ حٌم١خَ رٙخ فاٟ حٌّغاظمزً رخٌى١ف١اش ٚحٌٛلاض 

 حٌّلاث١ّٓ ٌظٕف١ز٘خ .

٘ااٛ حٌعلالااش راا١ٓ  انثاابَي٘ااٛ حٌّغااظمزً ،  الأٔلأْ حٌظخطاا١ؾ ٌااٗ علالااش ِزخشااشس رعٕظااش٠ٓ سث١غاا١١ٓ : 

 حلأ٘ذحف ٚحٌطشق حٌّغظخذِش ٌظلم١ك ٘زٖ حلأ٘ذحف .

ٌٕٚـخف ع١ٍّش حٌظخط١ؾ ٠ـذ حلا٘ظّخَ رٕٛع١اش حٌّاذسحء حٌاز٠ٓ ٠مِٛاْٛ رٙازٖ حٌّّٙاش ، ف١ـاذ أْ طىاْٛ 

ؽ٠ٍٛش فٟ حٌعًّ ، وزٌه حٌمذسس عٍٝ حٌلظٛي عٍٝ حٌّعٍِٛخص حٌؼشٚس٠ش لاعظخذحِٙخ فٟ ٌذ٠ُٙ خزشس 

 ٚػع خطؾ طظطخرك ِع كخؿخص حٌّٕظّش ِٚشخس٠عٙخ حٌّخظٍفش .

 

 انسبخخ إنٗ انزخن ؾ في انًشبسيغ 

أْ حٌلخؿش ٌٍظخط١ؾ ٔشؤص لاْ ِعظُ حٌّٕظّخص ِٚشخس٠عٙخ حٌّخظٍفش طعًّ فٟ ظشٚف ر١ج١ش ِظر١شس فٟ 

 -: ح٢طٟ

 حٌظر١شحص فٟ حٌغ١خعخص حٌلى١ِٛش .  -

 حٌظر١ش فٟ حٌعٛحًِ حلالظظخد٠ش .  -

 حٌظر١شحص فٟ حٌعٛحًِ حلاؿظّخع١ش ٚحٌؼمخف١ش . -

 حٌظر١شحص فٟ حٌّٛحسد حٌزشش٠ش ٚحٌّخد٠ش . -
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 حٌظر١شحص فٟ حرٚحق حٌّغظٍٙى١ٓ . -

 حٌظر١شحص فٟ ح١ٌٙخوً حٌظٕظ١ّ١ش ، ٚػمخفش حٌّٕظّش ٚحٌّٛحسد رشىً عخَ . -

 

 ّ ْ انزخن ؾ يب 

ٚظ١فش حٌظخط١ؾ ِٓ أُ٘ حٌٛظخثف حلإدحس٠ش لأٔٙاخ طغازمٙخ ؿ١ّعاخ  ٠ٚاظُ فاٟ ٘ازٖ حٌٛظ١فاش ٚػاع حلأ٘اذحف 

 ٚٚػع حٌغ١خعخص حٌىف١ٍش رظلم١مٙخ .

 ٘ٛ عزخسس عٓ ؽش٠ك حٌزٞ ٠ظُ طلذ٠ذٖ رظٛسس ِغزمش ٌظلم١ك حلأ٘ذحف . انزخن ؾحْ 

٘ٛ ع١ٍّش رو١ش ٚطظشف رٕٟ٘ ٌعًّ حلأشا١خء رطش٠ماش ِٕظّاش ٌٍظفى١اش لزاً حٌعّاً ، ٚحٌعّاً  فبنزخن ؾ 

 فٟ ػٛء حٌلمخثك رذلا  ِٓ حٌظخ١ّٓ .

 -ٔرؼى ػًه خ انزخن ؾ يدًٕػخ يٍ انخنٕاد ْٔي  

 ٚػع حلأ٘ذحف . -

 دسحعش حٌظر١شحص فٟ حٌعٛحًِ حٌز١ج١ش . -

 ٚػع حٌخطؾ . -

 الشحس حٌخطؾ ٚحعظّخد٘خ . -

 طٕف١ز حٌخطؾ . -

 ِظخرعش حٌخطؾ ٚسلخرظٙخ ٚطم١١ّٙخ . -

 

  إَٔاع انزخن ؾ 

لاذ ٠ىاْٛ طخطا١ؾ ؽ٠ٛاً حلأؿاً ، ِٚظٛعاؾ حلأؿاً ، ٚلظا١ش  -أٔلاً   انزخن ؾ زغت ان زشح انضيُ اخ  

 حلأؿً .

لذ ٠ىْٛ طخط١ؾ حلظظخدٞ أٚ ِخٌٟ أٚ طخط١ؾ طإخعٟ أٚ أشاخثٟ أٚ  -ثبَ بً   انزخن ؾ زغت انُشبؽ  

 طخط١ؾ ٌّشخس٠ع ِخظٍفش .

فماااذ ٠ىاااْٛ حٌظخطااا١ؾ ِظىاااشس حلاعاااظعّخي ِؼاااً ٚػاااع  -ثبنثاااب   انزخنااا ؾ زغااات يدااابل الاعااازؼًبل  

حلاعظشحط١ـ١خص ، ٚحٌغ١خعخص ، ٚحٌمٛحعذ ٚحلإؿشحءحص ، أٚ ٠ىْٛ حٌظخط١ؾ غ١ش ِظىاشس حلاعاظعّخي ِؼاً 

 ٚػع حٌزشحِؾ ٚحٌّٛحصٔخص حٌظمذ٠ش٠ش .

 حٌظخط١ؾ لأ١ّ٘ظٗ فٟ ادحسس حٌّشخس٠ع . عٛف ٔشوض عٍٝ ٘زح حٌٕٛ, ِٓ -ساثؼبً   رخن ؾ انًشبسيغ  
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  رخن ؾ انًشبسيغ 

ٚحٌظاٟ طغازك حٌٛظاخثف  حلأوؼاش أ١ّ٘اش فاٟ ع١ٍّاش ادحسس حٌّشاشٚ,ٚ حلأٌٚاٝ ٠عظزش طخط١ؾ حٌّششٚ, حٌخطاٛس

أر ٠مَٛ ِذ٠ش حٌّششٚ, ٚأعؼخء فش٠مٗ رظلذ٠ذ حلأ٘ذحف ٚطلذ٠ذ ؽاشق طٕف١از٘خ  , ٌٍّششٚ, حلإدحس٠ش حلأخشٜ

ٚػآّ ح١ٌّضح١ٔاش , ٌزٌه فؤْ ٘ذف ِذ٠ش حٌّششٚ, ٘ٛ ا٠ظخي حٌّشاشٚ, اٌاٝ ٔمطاش حٌٕٙخ٠اش رخٌٛلاض حٌّلاذد 

رؤٔااٗ )٘ااٛ أدحٖ ٌزٕااخء طظااٛس ِغاازك عاآ ِشحكااً طٕف١ااز  رخناا ؾ انًشااشٔع٠ّٚىاآ طعش٠ااف  .حٌّخظظااش ٌااٗ 

حٌٙاذف حلأعخعاٟ حٌازٞ ٠ىّآ ٚ ظٛس حٌّخخؽش حٌّظٛلعش حٌظٟ عاظٛحؿٗ حٌّشاشٚ, عٕاذ طٕف١ازٖ(حٌّششٚ, , ٚط

 -ٚسحء طخط١ؾ حٌّششٚ, ٘ٛ :

 طلذ٠ذ ِظطٍزخص حٌّششٚ, . -1

 طلذ٠ذ وٍفش حٌّششٚ, ٚٚػع ؿذٌٚش ٌٙخ . -2

٠ّٚىآ  حٌزلغ عٓ حٌّظخدس حٌظٟ ٠ّىٓ حٌلظٛي ِٓ خلاٌٙخ عٍٝ حٌّٛحسد حٌّطٍٛرش لإٔـخص حٌّششٚ, . -3

 -ع١ٍّش طخط١ؾ حٌّششٚ, رىً ِظطٍزخطٗ ِٓ خلاي حٌشىً حٌظخٌٟ : طٛػ١ق

 ( ػًه خ رخن ؾ انًششٔع ثكم يزنهجبرٓب1ٔيٕػر انشكم )

 

ِٚاآ خاالاي حٌشااىً أعاالاٖ ٔظٛطااً اٌااٝ حلأدٚحس حٌظااٟ ٠ٍعزٙااخ حٌّااذ٠ش ٠ٚاائدٞ ِاآ خلاٌٙااخ ٚحؿزخطااٗ فااٟ ظااً 

حٌّٙااخسحص حٌظااٟ ٠ظّظااع رٙااخ ربِىخٔااٗ حْ ٠لمااك خطااش حٌّشااشٚ, عٍااٝ أْ ٠ىااْٛ ِااذ٠ش حٌّشااشٚ, ٘ااٛ ِلااٛس 

دابص إناٗ ػاذح يٓابو ْٔازِ انًٓابو ركإٌ ك  هاخ فاي أَ يسزابج رخنا ؾ انًشاشٔعكًاب ٔ .حٌّششٚ, ِٚشوضٖ 

  -ٔإَدبذ انًششٔع ٔأًْٓب  

 طم١ًٍ حٌّخخؽش عٓ حٌّششٚ, لألً ِخ ٠ّىٓ . -1
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 طلم١ك ِٛحطفخص حلإدحء حٌخخص ٌٍّششٚ, . -2

 أٔشخء ١٘ىً طٕظ١ّٟ ٌظٕف١ز حلأعّخي . -3

 اعذحد حلإؿشحءحص حٌخخطش ٌٍظلىُ فٟ حلأعّخي . -4

 طلم١ك ٔظخثؾ أفؼً فٟ ألً ٚلض ِّىٓ . -5

 

 يكَٕبد رخن ؾ انًششٔع 

 -حٌّششٚ, ِخ ٠ٍٟ :٠ٚشًّ طخط١ؾ  

ٚطلظٛٞ عٍٝ ط١خغش أوؼش طفظ١لا  ٌس٘ذحف حٌعخِش , ٚطشًّ حلأ٘اذحف حٌظم١ٕاش ٚحٌظٕخفغا١ش ,  -الأْذاف   -1

ٚطلم١ك حلأسرخف , ٚطغ١ٍُ حٌٕظاخثؾ حٌٕٙخث١اش ٌٍع١ّاً رّاخ ٠لماك سغزخطاٗ , ٚوازٌه طلم١اك حلأ٘اذحف حٌشاخٍِش 

 ٌٍّٕظّش .

حٌّشاشٚ, , ٚاؽاخسٖ حٌضِٕاٟ حٌالاصَ ٌظٕف١ازٖ , ِاع  ٚ٘ٛ ٍِخض لظ١ش ِٚٛؿض لأ٘ذحف -انؼشع انؼبو   -2

طٛػ١ق ِٛؿض ٌلإدحسس حٌع١ٍخ ٌٍّٕظّش ٚعلالظٙخ ٚأ١ّ٘ظٙخ فٟ طٛؿ١ٗ ِذ٠ش حٌّشاشٚ, , ٚطٛػا١ق أ٘اذحف 

 حٌّششٚ, ٚعلالظٗ رؤ٘ذحف حٌّٕظّش .

طلذ٠ااذ حلأؽااشحف حٌّاائػشس ٚحٌّظااؤػشس رخٌّشااشٚ, ِااع طلذ٠ااذ حلألغااخَ حٌٛظ١ف١ااش فااٟ  -َناابا انًشااشٔع   -3

ٕظّش حٌظٟ عظغخعذ عٍٝ أـخص حٌّششٚ, ِٚخ ٘ٛ حٌّطٍٛد ِٓ وً لغُ ِآ واً ِشكٍاش ِآ ِشحكاً حٌّ

 حٌّششٚ, .

 -ٚطمغُ اٌٝ : -انق ٕد ٔانً ضاَ بد انزقذيشيخ   -4

ٟ٘ حٌّلاذدحص حٌّفشٚػاش عٍاٝ حٌّشاشٚ, ِٚآ أِؼٍظٙاخ )ل١اٛد حٌٛلاض , ل١اٛد حٌىٍفاش , ٚل١اٛد  حٌم١ٛد - أ

 حٌـٛدس( .

فظشاًّ طماذ٠شحص طمش٠ز١اش ٌظىاخ١ٌف حٌّشاشٚ, ِٛصعاش كغاذ ِشحكاً دٚسس أِخ حٌّٛحصٔخص حٌظمذ٠ش٠ش  - ة

 ك١خس حٌّششٚ, .

ٟٚ٘ حلأؽشحف حٌّٙظّش رخٌّششٚ, ٚ٘اُ )حٌّاخٌىْٛ ٌٍّشاشٚ, , ٚحٌٌّّٛاْٛ ٌاٗ , ٚحٌّٕظّاش  -الأؽشاف   -5

ٚحٌّااٛسدْٚ , ٚحٌّغااظف١ذ ِاآ حٌّشااشٚ, ٚ٘ااٟ حٌـٙااش حٌظااٟ ٠ٕفااز حٌّشااشٚ, , حلأَ , ٚحٌّٕفااز ٌٍّشااشٚ, 

, ٚواً ؽاشف ِآ ٘اازٖ حلأؽاشحف ٌٙاخ حلأ٘اذحف حٌخخطاش رٙااخ ٚعٍاٝ ِاذ٠ش حٌّشاشٚ, طلم١ااك  (ٌظاخٌلٙخ

 حٌّٛحصٔش ر١ٓ طلم١ك ٘زٖ حلأ٘ذحف .

 ٠ٚظف حٌظظ١ُّ ح١ٌٙىً حلإدحسٞ حٌّغظخذَ فٟ حٌّششٚ, ٚعلالظٗ رخٌّٕظّش ٚأ٘ذحفٙخ . -انزظً ى   -6
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ٚحٌظاااعٛرخص حٌظاااٟ عاااظٛحؿٗ أٞ حٌعّاااً عٍاااٝ طل١ٍاااً حٌّخاااخؽش ٚأٔٛحعٙاااخ ِٚظاااخدس٘خ ,  -انًخااابؽش   -7

حٌّششٚ, عٕذ طٕف١زٖ , ِع أعذحد حٌخطاؾ ٚح١ٌ٢اخص حٌلاصِاش ٌّٛحؿٙاش ٘ازٖ حٌّخاخؽش ٚطم١ٍاً آػخس٘اخ عٕاذ 

 طٕف١ز حٌّششٚ, .

٠خطؾ ٘زح حٌمغُ حٌـذحٚي حٌض١ِٕاش ٌظٕف١از واً ِّٙاش فاٟ حٌّشاشٚ, ِٚآ حٌّغائٚي عآ أدحء  -اندذأل   -8

 ّظفك ع١ٍٙخ .حٌّّٙخص ٚطٛل١عٗ عٍٝ حٌـذٌٚش حٌٕٙخث١ش حٌ

ٚطشااًّ لخثّااش ٚأٚطااخف وخٍِااش ٌسؽااشحف حٌظعخلذ٠ااش ٌٍّشااشٚ, حٌّاازوٛسس عااخرمخ  ,  -الأٔخااّ انزؼبقذيااخ   -9

ٚحٌظشط١زااخص ٚػ١مااش حٌظااٍش رخٌّشااشٚ, , ِٚظطٍزااخص ِخٌااه حٌّشااشٚ, , ٚحٌظعخلااذ ِاآ حٌزااخؽٓ ٚحٌظغاا١ٍّخص 

 ِٚٛحطفخطٙخ , ِٚذس طٕف١ز حٌّششٚ, ٚؿذٌٚش طغ١ٍّٗ ٌٍع١ًّ . حٌٕٙخث١ش

أٞ طلذ٠ذ ِظطٍزخص حلأفشحد حٌّظٛلعاش ٌظٕف١از حٌّشاشٚ, , ِٚٙاخسحطُٙ ٚأٔاٛح, حٌظاذس٠ذ حٌلاصِاش  -الأفشاد   -10

ٌُٙ , ٚحلأِٓ ٚحٌغلاِش ٌُٙ أػٕخء طٕف١ز حٌّششٚ, , ِع طلذ٠ذ عذد ِٓ حلأفشحد حٌّطٍٛر١ٓ ٌظٕف١ز حٌّشاشٚ, 

 عٍٝ ِم١خط حٌٛلض فٟ ؿذٌٚش حٌّششٚ, .

 

  يضايب رخن ؾ انًششٔع 

  -ٕ٘خٌه عذس ِضح٠خ ٌظخط١ؾ حٌّششٚ, ِٕٙخ :

لأْ حٌظخط١ؾ ٠لذد ِغازمخ  حٌّشاخوً ٚحٌّخاخؽش حٌظاٟ عاظٛحؿٗ حٌّشاشٚ, عٕاذ  -ت غ كه خ انًششٔع   -1

طٕف١زٖ , ٚطىٍفش ٘زح حلأؿشحء طىْٛ ألً ِمخسٔاش رخٌظىاخ١ٌف حٌٕخؿّاش عآ ٔاٛ, ٘ازٖ حٌّخاخؽش عٕاذ ِشكٍاش 

 طٕف١ز حٌّششٚ, .

, ٚ٘ازٖ ٌظخط١ؾ ٌٍّششٚ, ٠شظشن ف١ٗ وخفش حلأؽشحف حٌّٙظّش رخٌّششٚ, لأْ ح -ت غ يذح انًششٔع   -2

حٌّشخسوش طٙذف اٌٝ طل١ًٍ حٌـذٚي حٌضِٕٟ حٌّظٛلع ٌّشحكً حٌّششٚ, , ٚفٟ أؽاخس ٘ازٖ حٌّشاخسوش ٠اظُ 

أ٠ؼخ  اؿاشحء حٌظر١١اشحص رشاىً أعاًٙ ِمخسٔاش ِاع طاعٛرش ٚوٍفاش حٌظر١١اش عٕاذ حٌّزخشاشس رع١ٍّاش حٌظٕف١از 

 حخظظخس حٌذٚسس حٌض١ِٕش حٌلاصِش ٌظٕف١ز حٌّششٚ, . ٚطغخُ٘ أ٠ؼخ  فٟ

٠ٍعذ طخط١ؾ حٌّششٚ, دٚسح  سث١غ١خ  فٟ طلذ٠ذ طٛلعخص ٚحكظ١خؿخص حٌع١ًّ  -رسغ ٍ خٕدح انًششٔع   -3

فٟ ِشكٍش طعش٠ف حٌّششٚ, ٚحٌظخط١ؾ ٌـٛدس حٌّششٚ, , فظخط١ؾ حٌّششٚ, ٠غخعذ عٍٝ طلم١ك ٘ذف 

ِع طٛلعخص حٌع١ًّ حٌزٞ ٠شظشن ِٕز حٌزذح٠ش فٟ طخط١ؾ حٌّششٚ, حٌـٛدس ٌٍّششٚ, , ِغزمخ  ٚرّخ ٠ظلاءَ 

 , ٚ٘زح ٠غخعذ عٍٝ طلم١ك حٌـٛدس حٌظٟ ٠شغزٙخ حٌع١ًّ عٕذ طغٍّٗ حٌٕخطؾ حٌٕٙخثٟ ٌٍّششٚ, .

أ٠ؼاخ  فاٟ ٠غخعذ طخط١ؾ حٌّششٚ, عٍٝ حعظرلاي حلأِؼً ٌّاٛحسد ٚاِىخ١ٔاخص حٌّٕظّاش ٚطلم١اك حٌىفاخءس  -4

 خعذ ٚػّٓ حٌظىخ١ٌف حٌّخططش .أٙخء حٌّششٚ, فٟ حٌٛلض حٌّٕ
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٠غخعذ طخط١ؾ حٌّشاشٚ, عٍاٝ طلماك أ٘اذحف حٌّٕظّاش حلأَ ٚحٌّظّؼٍاش فاٟ طلم١اك ألظاٝ سراق ِّىآ ,  -5

     ٚطخف١غ حٌظىخ١ٌف , ٚحٌّٕٛ ٚحٌزمخء ٚحلاعظّشحس ٌٍّٕظّش . 

 

  دٔسح ز بح انًششٔعProject Life Cycle  

رذح٠ظٙخ كظاٝ حٔظٙخثٙاخ ٚطعاشف ٘ازٖ حٌّشحكاً رؤٔٙاخ دٚسس طّش ِعظُ حٌّششٚعخص خلاي ِشحكً ِظشخرٙش ِٓ 

 ك١خس ٌٍّششٚ, .

٠اظُ حخظ١اخس حٌّاذ٠ش , ػاُ ٠اظُ طـ١ّاع فش٠اك حٌّشاشٚ, ٚحٌّاٛحسد ِٓ ػاُ )ِشكٍش حٌزذح٠ش( , ٚ رـ ف١ٌٛذ حٌّششٚ,

 ٌاه كظاٝ ٠ظاًحلأ١ٌٚش , ٠ٚظُ طٕظ١ُ رشٔخِؾ حٌعّاً , ػاُ ٠زاذأ حٌعّاً , ٠ٚلاذع حٌظماذَ فاٟ حٌعّاً , ٠ٚغاظّش ر

 -حٌّشحكً فٟ دٚسس ك١خس حٌّششٚ, ٟ٘ : ِٚٓ ٘زٖحٌّششٚ, اٌٝ حٌٕٙخ٠ش , 

طظؼّٓ ٘زٖ حٌّشكٍش دسحعش حٌلخؿش اٌاٝ حٌّشاشٚ,   -انًشزهخ الأٔنٗ / يشزهخ أدساك فكشح انًششٔع   -1

, ٚدسحعش ؿذٜٚ ِزذث١ش ٌٍّششٚ, طظؼّٓ حٌذسحعش حٌف١ٕش ٚحٌّخ١ٌش , ٚوازٌه حلإؿخراش حٌّزذث١اش عٍاٝ عاذد 

 حلأعجٍش ِؼً : وُ ع١ىٍف حٌّششٚ, , ِٚظٝ ع١زذأ , ِٚخرح ع١لمك حٌّششٚ, .ِٓ 

ٚطظؼّٓ ٘زٖ حٌّشكٍش طلذ٠ذ حٌّٛحسد حٌلاصِاش , ٚٚػاع  -انًشزهخ انثبَ خ / يشزهخ رؼشيف انًششٔع   -2

حٌخطؾ حٌظفظ١ٍ١ش حٌلاصِش ٌظٕف١ز حٌّششٚ, , ٚٚػع حٌّٛحصٔاخص ٚحٌـاذحٚي حٌض١ِٕاش ٌٍّشاشٚ, , ٚٚػاع 

 خص ٚطلذ٠ذ حلإؿشحءحص حٌلاصِش ٌٍم١خَ رخٌٕشخؽخص حٌّخظٍفش .حلاعظشحط١ـ١

ٚطظؼآّ ٘ازٖ حٌّشكٍاش حٌشلخراش عٍاٝ طٕف١از حٌّشاشٚ, ,  -انًشزهخ انثبنثاخ / يشزهاخ انزُ  از أٔ الإَزابج   -3

ٚسفع حٌظمخس٠ش كغذ حٌلخؿش )١ِٛ٠خ  , أعزٛع١خ  , شٙش٠خ ( وّخ طُ طٕف١زٖ , ٚوزٌه ِمخسٔش ِاخ طاُ طٕف١ازٖ ِاع 

 ظخط١ؾ ٌٗ , ٚطم١١ُ ِذٜ حلألشحفخص ٚوزٌه حطخخر حلإؿشحءحص حٌظظل١ل١ش .ِخ طُ حٌ

ٚطظؼآّ ٘ازٖ حٌّشكٍاش , طماذ٠ُ حٌخذِاش ٚحٌّٕاظؾ حٌٍاز٠ٓ  -انًشزهخ انشاثؼخ / يشزهخ رشاغ م انًشاشٔع   -4

٠ٙااذف حٌّشااشٚ, اٌااٝ طمااذ٠ّٙخ , ٚطىخٍِّٙااخ ِااع حٌّٕظـااخص ٚحٌخااذِخص حٌظااٟ طمااذِٙخ حٌّشااخس٠ع حلأخااشٜ , 

 طلم١ك حٌّششٚ, ٌس٘ذحف حٌّٛػٛع١ش .ٚطم١١ُ ِذٜ 

ٚطظؼاآّ ٘اازٖ حٌّشكٍااش طظااف١ش ٚحٔٙااخء حٌّشااشٚ,  -انًشزهااخ انخبيغااخ / يشزهااخ َٓبيااخ انًشااشٔع   -5

ٚطل٠ًٛ ِٛحسد حٌّششٚ, اٌٝ ِشخس٠ع أخشٜ ٚحلاعظفخدس ِٓ حٌذسٚط حٌخخطش رٙزح حٌّششٚ, . ٚحٌشاىً 

 -حٌظخٌٟ ٠ٛػق دٚسس ك١خس حٌّششٚ, :
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 ز بح انًششٔع( دٔسح 2انشكم )

 

 ٔ يٕاط بد يذيش انًششٔعتظبئض 

ٌىٟ ٠ىْٛ ِذ٠ش حٌّششٚ, ٔخؿق فٟ أعّخٌٗ لا رذ أْ طىْٛ ٕ٘خٌه ِـّٛعاش ِآ حٌخظاخثض ٚحٌظافخص حٌظاٟ 

  -٠ـذ أْ ٠ظّظع رٙخ ِذ٠ش حٌّششٚ, عٕذ حخظ١خسٖ ِٓ لزً حلإدحسس حٌع١ٍخ ٌٍّٕظّش ٚطظّؼً فٟ ح٢طٟ :

 خٍف١ش طم١ٕش .أْ ٠ىْٛ شخض ٔخػؾ ِٚذ٠ش شخِه ٌٚٗ  -1

 أْ ٠ىْٛ رٚ عّعش ؽ١زش , ٚشخض ٌذ٠ٗ خزشس ٚعزك أْ عًّ فٟ ألغخَ عذ٠ذس ِٚشخس٠ع ِخظٍفش . -2

أْ ٠ىْٛ ٌذ٠ٗ ِظاذحل١ش عاٛحء أوخٔاض ِظاذحل١ش طم١ٕاش , رّعٕاٝ أْ ٠ىاْٛ ٌاذٜ ِاذ٠ش حٌّشاشٚ, حٌّعشفاش  -3

شٚ, ٚطؤد٠ش ٘زٖ حٌّٙخَ ٌظٛؿ١ٗ ٚطلم١ك أ٘ذحف حٌّششٚ, , أٚ ِظذحل١ش طغ١١ش أعّخي حٌّش حٌظم١ٕش حٌىخف١ش

 رّٙخسس عخ١ٌش ٠ٚىْٛ ِغئٚي عٓ أطخخر حٌمشحسحص حٌّٕخعزش حٌلى١ّش ٚحٌٕخػـش .

كخؿااش ِااذ٠ش حٌّشااشٚ, اٌااٝ حٌلغخعاا١ش حٌغ١خعاا١ش ٚحلاعظشااعخس حٌغ١خعااٟ حٌـ١ااذ ٌلإكغااخط رخٌخلافااخص  -4

 حٌشخظ١ش ٌذٜ فش٠ك حٌعًّ ١ٌلفضُ٘ ٠ٚـعٍُٙ ٠عٍّْٛ فٟ ٚػع ٘خدة ِٚغظمش .

٠ىْٛ ِذ٠ش حٌّششٚ, لخثذ حعظشحط١ـٟ ٚفعخي ٌٚذ٠ٗ حٌلّخط ٚحلإرذح, , ٚأْ ٠ىْٛ لخدس عٍٝ حٌم١خدس , أْ  -5

حٌظعخًِ ِع حٌعٕظش حٌزششٞ حٌعخًِ فٟ ٘زح حٌّششٚ, ٚأْ ٠ىْٛ لخثذح  ٠ظّظع رخلأخلاق ٚلخدس عٍٝ ل١اخدس 

 فش٠ك حٌعًّ فٟ حٌّششٚ, ٚطلف١ضُ٘ رخعظّشحس .

٠ٗ حٌمذسس عٍٝ حٌظى١١اف ٚحٌظاؤلٍُ ِاع عٛحِاً حٌز١جاش حٌذحخ١ٍاش حٌمذسس عٍٝ حٌظعخًِ ِع حٌؼرؾ رؤْ طىْٛ ٌذ -6

 ٚحٌخخسؿ١ش .
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أْ ٠ىْٛ ٌذٜ ِذ٠ش حٌّشاشٚ, دسؿاش ِآ حٌظعٍا١ُ ٚحٌشاٙخدحص حٌلخطاً ع١ٍٙاخ ِٕخعازش ٌّـاخي حٌعّاً فاٟ  -7

 ٚأْ ٠ىْٛ ٌذ٠ٗ عٕٛحص ِٓ حٌخزشس فٟ ِششٚعخص ِظشخرٙش . , حٌّششٚ, , ٚأْ ٠ـ١ذ ٌرخص أؿٕز١ش

حٌظم١ٕااش , ٚحلإدحس٠ااش , ٚحٌفىش٠ااش , ٚحلإٔغااخ١ٔش حٌّٕخعاازش ٚحٌلاصِااش ٌظغاا١١ش أعّااخي  أْ ٠ظّظااع رخٌّٙااخسحص -8

حٌّششٚ, رٕـخف ِظ١ّض , ٚطشًّ ٘زٖ حٌّٙخسحص أ٠ؼخ  )ِٙخسحص حلاطظخي , ِٚٙخسحص حٌمذسس عٍٝ طلف١ض 

حٌفااشحد حٌعااخ١ٍِٓ فااٟ حٌّشااشٚ, , ِٙااخسحص حٌم١ااخدس ٚحٌمااذسس عٍااٝ حٌظااؤػ١ش عٍااٝ ح٢خااش٠ٓ , ِٙااخسحص كااً 

ّشااخوً ٚحطخااخر حٌمااشحسحص , ِٙااخسحص حٌفٙااُ حٌىخِااً ٌٍظىٌٕٛٛؿ١ااخ , ِٙااخسحص حٌفٙااُ حٌىخِااً لالظظااخد٠خص حٌ

 حٌّششٚ,( .

 

  يغؤٔن بد يذيش انًششٔع 

 -أْ ِغئ١ٌٚش ِذ٠ش حٌّششٚ, ِظعذدس ٚطظؼّٓ حٌّغئ١ٌٚخص حٌظخ١ٌش :

 -أٔلاً // يغؤٔن خ يذيش انًششٔع في يدبل انزخن ؾ , ٔرزًثم في الآري  

 ٌظر١شحص ٚحلإ٠ؼخكخص ٌٍّششٚ, ِٚشحكٍٗ ٚخطٛحطٗ ٚحلأٔشطش حٌلاصِش ٌٗ .ٚػع ح - أ

 ٚػع خطؾ طظخرع ٚؿذٌٚش حلأٔشطش حٌلاصِش ٌٍّششٚ, . - ة

 ٚػع شزىش أٔـخص حٌّششٚ, . - د

 . WBS)طل١ًٍ حٌّشاشٚ, اٌاٝ أؿاضحء فشع١اش أٞ طـضثاش عّاً حٌّشاشٚ, اٌاٝ ؿضث١اخص أٚ ِاخ ٠غاّٝ ) - س

 حٞ طمغ١ُ أٚ طل١ًٍ ِظطٍزخص حٌّششٚ,   Work Breakdown Structure)ٚطعٕٟ )

طشًّ ِغائ١ٌٚخص ِاذ٠ش حٌّشاشٚ, فاٟ ٘ازح  -ثبَ بً // يغؤٔن خ يذيش انًششٔع في يدبل رُظ ى انًششٔع  

 -حٌّـخي ِخ ٠ٍٟ :

 ٚػع حٌخش٠طش حٌظٕظ١ّ١ش ٌٍّششٚ, .  - أ

 طلذ٠ذ حٌّغئ١ٌٚخص ٚحلاخظظخطخص ٌـ١ّع حلأفشحد حٌعخ١ٍِٓ فٟ حٌّششٚ, .  - ة

 طلذ٠ذ حلأدٚحس ٚحٌعلالخص ِع ادحسحص حٌّٕظّش ٚأؽشحف حٌّششٚ, .  - د

 حخظ١خس فشق حٌعًّ ٌٍّششٚ, .  - س

 -ٔرزًثم في الآري   -ثبنثبً // يغؤٔن خ انًذيش في يدبل انشقبثخ ٔانًزبثؼخ  

 طمذ٠ُ خش٠ؾ ؿخٔض ٌلإٔـخص .  - أ

 طمذ٠ُ حٌظمخس٠ش عٓ حٌـٛحٔذ ٚحٌّخظٍفش حلإٔـخص .  - ة

 ٚػع ِعخ١٠ش ٌٍظم١١ُ .  - د

 ِمخسٔش حلإٔـخص حٌفعٍٟ ِع حلأ٘ذحف حٌّخططش أٚ حٌّعخ١٠ش حٌّٛػٛع١ش ِغزمخ  .  - س

 حطخخر حلإؿشحءحص حٌظظل١ل١ش أٚي رؤٚي فٟ كخٌش ٚؿٛد أٞ حٔلشحفخص أػٕخء طٕف١ز حٌّششٚ, .  - ج
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  انٓ كم انزُظ ًي انًششٔع 

حٌّلاثاُ ٌٍّشاشٚ,  ٕ٘خن ِـّٛعش ِٓ حٌعٛحًِ ٠ـذ أْ ٔؤخاز٘خ فاٟ حٌلغازخْ عٕاذ حخظ١اخس ح١ٌٙىاً حٌظٕظ١ّاٟ

 -ٚأُ٘ ٘زٖ حٌعٛحًِ ٟ٘ :

 حعظشحط١ـ١ش حٌّٕظّش . -1

 دٚسس ك١خس حٌّششٚ, . -2

 ِذٜ طّشوض حطخخر حٌمشحس . -3

 حٌظخظض . -4

 حٌمذسحص حلإٔغخ١ٔش . -5

 حٌظىٌٕٛٛؿ١خ . -6

 ر١جش حٌّٕظّش . -7

 ػمخفش حٌّٕظّش . -8

 -ٚلزً حخظ١خس ح١ٌٙىً حٌظٕظ١ّٟ ٌٍّششٚ, ٠ٚـذ أؿشحء طل١ًٍ اٌٝ حٌعٛحًِ حٌظخ١ٌش :

 طل١ًٍ أٔشطش حٌّششٚ, . -1

 طل١ًٍ ِشحوض حطخخر حٌمشحسحص . -2

طل١ًٍ حٌعلالخص ر١ٓ ِذ٠ش حٌّششٚ, ٚحٌّذسحء ح٢خش٠ٓ ٌٍّشخس٠ع حٌّخظٍفش ٚوزٌه ِع حلألغاخَ حٌٛظ١ف١اش  -3

 ٌٍّٕظّش .

 طل١ًٍ حٌز١جش حٌّل١طش رخٌّششٚ, عٛحء حٌز١جش حٌذحخ١ٍش أَ حٌز١جش حٌخخسؿ١ش . -4

خ  عٍاٝ حخظ١اخس ٚطظا١ُّ ح١ٌٙىاً حٌظٕظ١ّاٟ ٌٍّشاشٚ, حٌازٞ ٠لماك أ٘اذحف ٚ٘زٖ حٌعٛحًِ حٌّزوٛسس طائػش كظّا

 حٌّششٚ, ِٚخشؿخطٗ حٌّظٛلعش .

 

  يشازم رظً ى انٓ كم انزُظ ًي نهًششٔع 

 -ٕ٘خن عذس ِشحكً ٌظظ١ُّ ح١ٌٙىً حٌظٕظ١ّٟ ٌٍّششٚ, ِٕٙخ :

 طلذ٠ذ أ٘ذحف حٌّششٚ, . -1

 أ٘ذحف حٌّششٚ, .طلذ٠ذ ٚطل١ًٍ أٚؿٗ حٌٕشخؽخص ٚحٌفعخ١ٌخص حٌلاصِش ٌظلم١ك  -2

 طمغ١ُ حٌٕشخؽخص حٌشث١غ١ش اٌٝ ٔشخؽخص فشع١ش ٠ٚىْٛ ٌىً ٔشخؽ ٚكذس ادحس٠ش خخطش رٙخ . -3

 طلذ٠ذ حخظظخطخص وً ٚكذس ادحس٠ش فٟ حٌّششٚ, . -4

 طلذ٠ذ علالخص حٌغٍطش ٚحٌّغئ١ٌٚش ر١ٓ ِخظٍف حٌٛكذحص حلإدحس٠ش . -5
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  انًجبدئ الأعبع خ في ثُبل انٓ كم انزُظ ًي نهًششٔع 

عذس ؽشق ٚأعاظ ِٚزاخدة ٌظمغا١ُ أٚؿاٗ ٔشاخؽ حٌّٕظّاش أٚ ٔشاخؽ حٌّشاشٚ, اٌاٝ ادحسحص أٚ ٚكاذحص ٕ٘خٌه 

 طٕظ١ّ١اش , ٌٚىاً ِاآ ٘ازٖ حٌطااشق ِضح٠خ٘اخ ٚع١ٛرٙااخ , ٌٚا١ظ ٕ٘ااخن ؽش٠ماش ِؼخ١ٌااش طظاٍق ٌٍظطز١ااك فاٟ وخفااش

ؼاً ٌىاً ِشاشٚ, خظٛطا١ظٗ ٚأ٘ذحفاٗ ٚظشٚفاٗ حٌظاٟ ٠ظظاف رٙاخ . ٚطظّ حٌّٕظّخص أٚ وخفش حٌّشاخس٠ع , ٌازح

  -حٌّزخدة حلأعخع١ش فٟ رٕخء ح١ٌٙىً حٌظٕظ١ّٟ فٟ حٌّزخدة  ٚحٌطشق حٌظخ١ٌش :

٘ز حٌظمغ١ُ ِٓ أوؼاش حٌطاشق شا١ٛعخ  ٠ٚاظُ رّٛؿزاٗ طمغا١ُ حٌّشاشٚ, ٠ٚعظزش   -انزقغ ى زغت انٕظ  خ   -1

اٌٝ عذد ِٓ حٌٛكذحص حٌظٕظ١ّ١ش طظٕخعذ ِع عذد ٚظخثف حٌّششٚ, , رل١غ طخاظض واً ٚكاذس طٕظ١ّ١اش 

ظ١فش ِع١ٕش ٌٍّششٚ, وىً . ك١غ ٠ىْٛ ٕ٘خن ِاذ٠ش عاخَ ٌٍّشاشٚ, , ػاُ ِاذ٠ش ٌلإٔظاخؽ , ِٚاذ٠ش ربدحء ٚ

 حٌظغ٠ٛك , ِٚذ٠ش ٌٍّٛحسد حٌزشش٠ش , ِٚذ٠ش ِخٌٟ ... حٌه .

٠ٚااظُ رّٛؿزااٗ طمغاا١ُ ٔشااخؽخص حٌّشااشٚ, كغااذ حٌغااٍع أٚ  -انزقغاا ى زغاات َاإع انغااهؼخ أٔ انخذيااخ   -2

,  ٕ٘اخن ِاذ٠ش عاخَ , ػاُ ِاذ٠ش حٌغاٍعش )أ( , ِٚاذ٠ش حٌغاٍعش )د( حٌخذِخص حٌظٟ ٠ٕظـٙخ أٚ ٠مذِٙخ . ف١ىْٛ

 ِٚذ٠ش حٌغٍعش )ؽ( , ٚ٘ىزح .

٠ٚظُ رّٛؿزٗ طمغ١ُ ٔشخؽخص حٌّششٚ, كغذ طغٍغً ِشحكً حٌعًّ  -انزقغ ى زغت يشازم انًششٔع   -3

, ففاٟ ِشااشٚ, طإخعٟ ِؼااً ِشاشٚ, طاإخعش حٌراضي ٚحٌٕغاا١ؾ ِاؼلا  ٠ىااْٛ ٕ٘اخن لغااُ لإدحسس حٌرااضي , 

 حٌه .ٌٕغ١ؾ , ٚلغُ لإدحسس حٌظزخغش ...لإدحسس حٚلغُ 

٠ٚظُ رّٛؿزٗ طمغ١ُ ٔشخؽخص حٌّششٚ, كغذ حٌعّلاء حٌز٠ٓ ٠اظُ حٌظعخِاً  -انزقغ ى زغت َٕع انؼً ل   -4

ِعُٙ ففٟ ِششٚ, طـخسٞ ِؼلا  ٠ىْٛ ٕ٘خن ِذ٠ش ٌٍّششٚ, , ِٚذ٠ش لغُ حٌّغظٍٙه , ِٚذ٠ش ٌمغُ طـخسس 

 ثش .حٌـٍّش , ِٚذ٠ش لغُ ٌظـخسس حٌظـض

٠ٚظُ رّٛؿزٗ طمغ١ُ ٔشاخؽخص حٌّشاشٚ, كغاذ حٌّٕاخؽك حٌـرشحف١اش  -انزقغ ى زغت انًٕقغ اندغشافي   -5

حٌظٟ ٠عًّ رٙخ ك١غ ٠ظُ طخظ١ض ٚكاذس طٕظ١ّ١اش ٌىاً ِٕطماش ٚطغاٍُ ِّٙاش حلاشاشحف ع١ٍٙاخ اٌاٝ ِاذ٠ش 

 ش )ؽ( .خخص رٙخ . ف١ىْٛ ٕ٘خن ِذ٠ش عخَ , ِٚذ٠ش ٌٍّٕطمش )أ( ِٚذ٠ش ٌٍّٕطمش )د( ِٚذ٠ش ٌٍّٕطم

٠ٚااظُ رّٛؿزااٗ طمغاا١ُ ٔشااخؽخص  -انزقغاا ى زغاات ٔخجاابد انؼًاام أٔ انزقغاا ى انضيُااي لأٔقاابد انؼًاام   -6

لإٔظخؽ أٚ طمذ٠ُ حٌخذِش فٟ فظاشس حٌّششٚ, عٍٝ أعخط ٚلض حٌعًّ اٌٝ ٚؿزخص طمَٛ وً ٚؿزٗ رّّخسعش ح

١ِٕش ِع١ٕش ف١ىْٛ ٕ٘خن ِذ٠ش عخَ , ػُ ِذ٠ش حٌٛؿزش حلأ١ٌٚش )حٌظزخك١ش( , ِٚاذ٠ش حٌٛؿزاش حٌؼخ١ٔاش )رعاذ ص

  حٌظٙش( , ِٚذ٠ش حٌٛؿزش حٌؼخٌؼش )حٌّغخث١ش( . 

 

  ٔاننشا الأعبع خ نٓب  انًششٔعخذٔنخ 

   Time Table)( اٌٝ ؿذٚي صِٕٟ )Project Planؿذٌٚش حٌّششٚ, ٟ٘ ع١ٍّش طل٠ًٛ خطش حٌّششٚ, )
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حرظااذحء  ِاآ ٌلظااش حٌّزخشااشس رخٌعّااً فااٟ حٌّشااشٚ, ِااشٚسح  رـ١ّااع حلأٔشااطش حٌّظظخرعااش ٌظشاار١ً حٌّشااشٚ, 

ٚحٌّظذحخٍش ٚحلأكذحع ٚحٌّلطخص حٌشث١غا١ش ٚطاٛلا  اٌاٝ ٌلظاش حٔظٙاخء حٌعّاً فاٟ حٌّشاشٚ, ٚطلذ٠اذ حٌٛلاض 

 حٌلاصَ ٌظٕف١ز حٌّششٚ, ِٓ ٌلظش حٌزذء ٚكظٝ ٌلظش حلأظٙخء .

حٌـذٌٚااش رعااذ حلأظٙاخء ِاآ طخطاا١ؾ حٌّشااشٚ, ٚطمغا١ّٗ اٌااٝ عٕخطااشٖ حٌشث١غاا١ش )حلأٔشااطش أٚ  ٚطاؤطٟ ِشكٍااش

حٌع١ٍّااخص حٌلاصِااش ٌظٕف١اازٖ( ٚرعااذ حلأظٙااخء ِاآ حٌشااىً حٌظٕظ١ّااٟ ٌٍّشااشٚ, رعااذ رٌااه طااؤطٟ ِغاائ١ٌٚش ِااذ٠ش 

دس ٚفاٟ كاذٚد ١ِضح١ٔاش ِلاذدس , ٚرـاٛدس ِٚٛحطافخص ِلاذ حٌّششٚ, فٟ اطّخَ حٌّششٚ, فاٟ طاخس٠ه ِعا١ٓ ,

 أ٠ؼخ  .

 -أيب اننشا الأعبع خ ندذٔنخ انًششٔع ْي  

 ْ كم ردضئخ انؼًم  -1

( ٠ٚلاكاع أْ ٘ازح Work Breakdown Structureحخظظاخسح  ٌّظاطٍق ) WBS)٠ٚشِاض ٌاٗ راخٌشِض )

٠ٚعاشف  . حٌّظطٍق ٠عىظ ع١ٍّش طـضثش حٌّششٚ, اٌٝ أؿضحء ٔظخ١ِاش ٚػآّ ِغاظ٠ٛخص ِظظخرعاش ِٚظظخ١ٌاش

((Turner ( حٌـ(WBS  عٍٝ أٔٗ )لذسس حٌّٕظّش فٟ طٛؿ١ٗ حٌظظخرعخص ٚحٌظذفمخص حٌظٟ طئٍ٘ٙخ ٚطزٕٟ لذسطٙخ

 فٟ طغ١ٍُ حٌّششٚ, رٛلظٗ ٚوٍفظٗ حٌّلذد٠ٓ( .

عٍٝ أٔٗ )حٌظشو١ذ حٌٙشِٟ ٌٍعّاً حٌّٛؿاٗ  ْ كم ردضئخ انؼًمف١عشف  PMI)أِخ ِعٙذ ادحسس حٌّششٚعخص )

 ٌٍظغ١ٍُ ٌرشع طٕف١زٖ ِٓ لزً فش٠ك حٌّششٚ, ٌظلم١ك أ٘ذحف حٌّششٚ, ٚا٠ـخد حٌظغ١ٍّخص حٌّطٍٛرش( .

ِٚٓ خلاي ٘زح ح١ٌٙىً ٠ظُ طـضثش حٌّششٚ, اٌٝ اؿضحء كغذ ٔٛ, حٌّششٚ, , ف١ـضأ اٌٝ )ِٕظـاخص فشع١اش( 

(Sub-Products ػُ ٠ظُ طـ١ّع حٌّىٛٔخص ). ٌٍّٗظشىً حٌّششٚ, رؤو 

 تشائؾ خبَذ -2

ِآ ألاذَ ٚأرغاؾ أعاخ١ٌذ حٌـذٌٚاش ٚحٌظل١ّاً حٌّغاظخذِش فاٟ حٌل١اخس  (Gantt Chartطعظزش خش٠طش ؿخٔاض )

غخٌز١ش حٌّٕشآص حٌع١ٍّش , ٚلذ لذِٙخ ٕ٘شٞ ؿخٔض أكذ سٚحد حٌلشوش حٌع١ٍّش ِٚخ صحٌض طغظخذَ كظٝ حلاْ فٟ 

أـاخص رعاغ ٠عشف رؤٔٗ )عزخسس عآ طظا٠ٛش ر١اخٟٔ ٠ّىآ راٗ طخطا١ؾ ٚؿذٌٚاش  ٔيخنؾ خبَذحٌظٕخع١ش , 

 حٌع١ٍّخص حٌّظظخرعش عٛحء وخْ رٌه عٍٝ ِشوض أظخؿٟ ٚحكذ أٚ عذس ِشحوض أظخؿ١ش ِخظٍفش( .

واازٌه فؤٔااٗ ٠ّىاآ حعااظخذحَ خش٠طااش ؿخٔااض وااؤدحس ٌظظزااع حلأدحء حٌاازٞ ٠ااظُ ٌىااً ع١ٍّااش , ِٚعشفااش ِااذٜ ططااخرك 

حٌـااذحٚي حٌّٛػااٛعش , وّااخ ٚطعظزااش خااشحثؾ ؿخٔااض ِاآ حلأعااخ١ٌذ حٌشلخر١ااش حٌٛطااف١ش  حٌظشاار١ً حٌفعٍااٟ ِااع

ك١اغ ٠ظٙاش  طظىْٛ ِٓ ِلاٛس٠ٓ أكاذحّ٘خ أفماٟ ٚحلاخاش عّاٛدٞٚٚحٌظم١ٍذ٠ش حٌظٟ طغظعًّ ٌّشحلزش حٌضِٓ , 

 عٍٝ حٌّلٛس حلأفمٟ حٌضِٓ , ٠ٚظٙش عٍٝ حٌّلٛس حٌعّٛدٞ أٔٛح, ٔشخؽخص حٌّششٚ, . 

ؿخٔض طغخعذٔخ عٍاٝ حٌظخطا١ؾ ٚحٌـذٌٚاش حٌخخطاش رخٌّشاخس٠ع حٌزغا١طش ٚحٌّعماذس , فٙاٟ ٚرخٌظخٌٟ فؤْ خشحثؾ 

طغخعذ أ٠ؼخ  ِذسحء حٌّشخس٠ع فٟ حٌـذٌٚش حٌّزذث١ش لأٔشطش حٌّشخس٠ع ٚفٟ ِشحلزش أـخص حٌّشحكاً حٌّظغٍغاٍش 
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ٚرعااذ  خص حٌّخططااش ِااع حٌع١ٍّااخص حٌفع١ٍااش ,حٌخخطااش رخٌّشااشٚ, عٍااٝ ِااذحس حٌٛلااض , ٚرٌااه رّمخسٔااش حٌع١ٍّاا

 حلأظٙخء ِٓ ع١ٍّش حٌـذٌٚش ٠ظُ طّؼ١ً وً ٔشخؽ رخؾ أفمٟ ٠ظٕخعذ ؽٌٛٗ ِع حٌٛلض حٌلاصَ ٌظٕف١ز رٌه حٌٕشخؽ.

 -يثبل // ػهٗ تشينخ خبَذ )انًنهٕة سعى يخنؾ خبَذ نلأَشنخ انزبن خ زغت اندذٔل أدَبِ  

 صيٍ انُشبؽ ثبلأعبث غ أعى انُشبؽ

 12 ط

 10 ص

 8 ع

ٔ 6 

 

 زٕل كم َشبؽ -ي زظبد  

 حٌٕشخؽخص )ط , ص( ٠زذأْ فٟ ٔفظ حٌٛلض أٞ ِظضح١ِٕٓ أٚ ِظٛحص١٠ٓ . -1

 حٌٕشخؽ ),( ٠زذأ رعذ أعزٛ, ِٓ رذح٠ش حٌٕشخؽ١ٓ )ط ,  ص( . -2

                        حٌٕشخؽ )ٚ( لا ٠ّىٓ أْ ٠زذأ حلا رعذ حلأظٙخء ِٓ حٌٕشخؽ ),( . -3

  

( أعاازٛ, 14حٌشااىً أعاالاٖ ٠ّؼااً ِخطااؾ ؿخٔااض ٌٍّشااشٚ, ٠ٚٛػااق حٌٛلااض حٌاالاصَ لأظٙااخء حٌّشااشٚ, ٘ااٛ )

ا حٌظاذحخً  ٚحٌظظاخرع ٌسٔشاطش ٚطٛلاف ادحء رعاغ حلأٔشاطش عٍاٝ حطّاخَ حلأٔشاطش حلأخاشٜ فّاؼلا  ٠ٚظٙاش أ٠ؼاخ

 حٌٕشخؽ )ٚ( لا ٠ّىٓ أْ ٠زذأ حلا رعذ حلأظٙخء حٌعًّ ِٓ حٌٕشخؽ ),( ٚ٘ىزح .

    -ِٕظّش أعّخي أظخؿ١ش طشغذ فٟ ألخِٗ ِششٚ, ٠ظؼّٓ حلأصِٕش ٚحٌفعخ١ٌخص حٌظخ١ٌش : يثبل //
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 انٕزذح انكً خ فقــــــشح

 3و خًهخ  الاَزقبل إنٗ يٕقغ انؼًم 

 3و 1200 انس شيبد 

 3و 360 تشعبَخ الأعظ

 3و 1100 تشعبَخ اندذساٌ

 3و 360 انذفٍ

 

 -عٓ ٘زح حٌّششٚ, : ٚلذ طٛفشص حٌز١خٔخص حلإػخف١ش حٌظخ١ٌش

َ 44حٌلفش٠خص  -1
3
 رخ١ٌَٛ . 

َ 24خشعخٔش حلأعخط  -2
3
 رخ١ٌَٛ . 

َ 44خشعخٔش حٌـذسحْ  -3
3
 رخ١ٌَٛ . 

َ 64حٌااذفٓ  -4
3
أ٠ااخَ عّااً ,  7. ٠ٚظطٍااذ حلأظمااخي اٌااٝ ِٛلااع حٌعّااً أعاازٛ, ٚحكااذ ك١ااغ حْ حلأعاازٛ,    

 . 1,2%   24% + 144% وخكظ١خؽ ٌزٌه طظزق ٔغزش حٌظٕف١ز  24رخلإػخفش اٌٝ ِخ طمذَ ٠ظُ أػخفش 

كغخد حٌّاذس حٌلاصِاش لإؿاشحء حٌلفش٠اخص , ٚلاض خشعاخٔش حلأعاخط , ٚلاض خشعاخٔش حٌـاذسحْ , انًنهٕة // 

 ٚرٌه ٚفك أعّخي حٌذفٓ ٚحٌظعز١ش عٓ رٌه ر١خ١ٔخ  .

 زغبة انًذح ان صيخ نهس شيبد . -1انسم // 

 حٌى١ّش                       

 ــــــ( * ٔغزش حٌظٕف١ز حٌلفش٠خص   )ــــــــــــــــــ

 اِىخ١ٔش حٌظٕف١ز                  

                      1244 

 أعخر١ع  ٠5َٛ أٞ ِخ ٠عخدي  35   1,2    ــــــــــــــــــــــــ *            

            44 

 ٔقذ تشعبَخ الأعبط زغبة -2

 حٌى١ّش   

 خشعخٔش حلأعخط   )ــــــــــــــــــــــــ( * ٔغزش حٌظٕف١ز 

 اِىخ١ٔش حٌظٕف١ز                            

 364 

 أعخر١ع  ٠3َٛ أٞ ِخ ٠عخدي  21,6   1,2   ــــــــــــــــــــــ *  

   24 

 زغبة ٔقذ تشعبَخ اندذساٌ -3
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 حٌى١ّش                                

 خشعخٔش حٌـذسحْ   )ــــــــــــــــــــــ( * ٔغزش حٌظٕف١ز 

 اِىخ١ٔش حٌظٕف١ز                           

                         1144 

 أعخر١ع   ٠5َٛ أٞ ِخ ٠عخدي  33   1,2  ـــــــــــــــــــ *                     

 44 

 زغبة ٔقذ أػًبل انذفٍ -4

 حٌى١ّش                          

 أعّخي حٌذفٓ   )ــــــــــــــــــــــ( * ٔغزش حٌظٕف١ز 

 اِىخ١ٔش حٌظٕف١ز                     

 364 

 ٠َٛ أٞ ِخ ٠عخدي أعزٛ,  7,2   1,2   ــــــــــــــــ *                

 64 

 -٠ٚظُ حٌظعز١ش عٓ رٌه ر١خ١ٔخ  وّخ فٟ حٌـذٚي حٌظخٌٟ :

 انكً خ انٕزذح انزشق ى

 انًذح

                     

 انُشبؽ

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

 خًهخ خًهخ 1
الاَزقبل إنٗ يٕقغ 

 انؼًم
 ــــ

 ـــــــــــــــــــــــــــــــ          انس شيبد 1200 3و 2

 ــــــــــــــــــــــــــ                                 تشعبَخ الأعبط 360 3و 3

 ــــــــــــــــــــــــــــــــــــــــــــــــــ                                                      تشعبَخ اندذساٌ 1100 3و 4

 ــــــــــ                                                                                               ػًه بد انذفٍ 360 3و 5

 

 -أعزٛ, ك١غ ٠ظُ كغخد رٌه وّخ ٠ٍٟ : 15حٌلاصِش ٌظٕف١ز حٌّششٚ, ٘ٛ  ٠ظؼق ِّخ طمذَ أْ حٌّذس

 أعزٛ,  1    اٌٝ ِٛلع حٌعًّ                

 أعخر١ع  5حٌلفش٠خص                            

 أعخر١ع 3خشعخٔش حلأعخط                    

 أعخر١ع  5خشعخٔش حٌـذسحْ                   

    أعزٛ,  1أعّخي حٌذفٓ                        

 أعجٕع 15انًدًٕع                           
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 وللأانفصم ا
 إدارة المشروع

 ؟انًشاسيغ إداسج  ييا ھ

( خ١ررٚاٌّبٌ خ٠اٌجشررش) ٚئداسح اٌّررٛاسد اٌّزبؽررخ ١ُرٕظرر خ١ررػٍّ ثأٔٙررب اٌّشرربس٠غئداسح  رؼررش 

رزىرْٛ ئداسح  ش١رؽ . خ١رلإٔغبص ِششٚع ِب ثغٛدح ٚوفبءح ػبٌ ش٘ب١ٚرغخ أِضً ٚاعزغلاٌٙب اعزغلالً 

اٌّرشاد  ()الأٔشرةخ اٌٛلرذ ٚاٌزىٍفرخ ٚاٌّرٛاسد ٚاٌّٙربَ ِٕٙرب   اٌؼٕبطرش ِٓ ِغّٛػخ ِٓ غ٠اٌّشبس

 .مٙب١رؾم

ٚالشرشا   ِٗٚزبثؼزر ّٗر١ٚرٕظ ٗةر١اٌّشرشٚع ئداسح اٌّشرشٚع ٚرخة ش٠ػٍٝ ػبرك ِذ مغ٠

فؼًلا ػٓ  . خ١ٚاٌخةؾ ٚاٌٛصبئك اٌشعّ ش١٠ٚفمبً ٌٍّؼب ز١ٖٚػّبْ رٕف اٌّششٚع، ز١رٕف بد١ػٍٝ ػٍّ

 ذ٠راٌؼّرً ٚرؾذ ك٠راٌّٙبَ ػٍٝ فش غ٠ٌخذِخ اٌّششٚع، ٚرٛص فٙب١ٚرٛظ اٌّٛاسد اٌّزبؽخ غ١ئداسح عّ

 خ٠رراٌؼلالرربد ٚاعرشاء ارظرربلد  دٚس ١ُ.ثبلإػرربفخ ئٌررٝ رٕظر بد١ٚاٌظرلاؽ ٚاٌٛاعجرربد بد١اٌّغرإٌٚ

أػٍرٝ  ك١ررؾم ؼر٠ّٓٚأطرؾبة اٌّظرٍؾخ .ثّرب  خ١اٌشعرّ اٌغٙربد اٌّشرشٚع ِرغ بد٠ِٚزبثؼخ ِغش

 .اٌفؼٍٟ عٛدح ٚوفبءح ٚارخبر اٌمشاساد فٟ ٚلزٙب

 

 غيأطش إداسج انًشاس

 ٚاٌؼٛاِرً اٌّخزٍفرخ اٌزرٟ ررإصش ػٍرٝ شاد١الؽلاع ػٍٝ أُ٘ اٌّزغ غت٠ ذ٠ِششٚع عذ ظ١رأع ػٕذ

 اٌّخرربؽش ٚالأٔشررةخ ؼررخ١ٚؽج خ١ررضا١ٔٚاٌفٛائررذ ٚاٌّ خ١رراٌّضرربي اٌؼٛائررذ اٌّبٌ ١ًعررج ػٍررٝ اٌّشررشٚع،

 .ز٘ب١ٚاٌّٙبَ اٌّشاد رٕف

 

 حیانجذونح انضيُ

ِرٓ الأٔشرةخ ٚاٌّٙربَ اٌّرشاد  ذ٠رػرّٓ ورً ِشؽٍرخ اٌؼذ مرغ٠ِرٓ ِشاؽرً ِخزٍفرخ،  غ٠اٌّشبس رزىْٛ

ثغررٌٙٛخ ِٚشٚٔررخ فررٟ  ز٘ب١رراٌّٙرربَ ٚرٕف ١ُاٌغررذٚي اٌضِٕررٟ ػٍررٝ رمغرر غرربػذ٠ اٌّشررشٚع، فررٟ ز٘ب١رررٕف

 اٌّششٚع. ١ُػٍٝ اٌغذٚي اٌضِٕٟ أٚ رغٍ شاد١رأخ ؽذٚس ِٛػذ٘ب اٌّؾذد دْٚ

 خطةةح انؼًةةم ( :(Action Plan أ٘ررُ  ذ٠ررٚرغرربُ٘ فررٟ رؾذ شح١اٌظررغ غ٠رغررزخذَ فررٟ اٌّشرربس

 .فٟ اٌّششٚع  ز٘ب١رٕف اٌخةٛاد اٌلاصَ

 انفجةةج میةذحه ( : (Gap Analysis ٘رٟ أداح رغرزخذَ ٌّغربػذح اٌشرشوبد ػٍرٝ ِمبسٔرخ الأداء

؟  أْ ٔىررْٛ ذ٠ررٔش ٠ٓرر؟ ٚأ ٔؾررٓ ٠ٓررأ   ١ٓٚرشوررض ػٍررٝ اعبثررخ عررإاٌ الأداء اٌّزٛلررغ . إٌّغررض ِررغ

 ِغ أ٘ذا  اٌّششٚع . زٕبعت٠ثّب  مٙب١رؾم اٌّشاد اٌّزةٍجبد ذ٠ٚرغبػذ فٟ رؾذ
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   اَةةدجيخطةةظ : (Gantt chart) اٌغررذٚي  ٛػررؼ٠ خ،١ة٠٘ررٛ أؽررذ أٔررٛاع اٌّخةةرربد اٌشررش

ثشرىً أوجرش فرٟ عذٌٚرخ  غرزخذ٠َأزٙبء٘رب . خ٠ثذء اٌّٙبَ ٚرربس خ٠ربس ش١ٌٍّششٚع ِٓ ؽ اٌضِٕٟ

 . شح١ٚاٌىج اٌّزٛعةخ غ٠اٌّشبس

 

 نهًششوع الأساسیحانًشاحم 

 اٌزخة١ؾ . 

 ٚاداسح اٌّششٚع . رزجغ 

 اٌّششٚع . أٙبء 

 

 إداسج انًششوع كيطش طحيخش

 Microsoft Project  2013ثشٔبِظ  أصٕبء اعزخذاَفُٙ ، اٌعٍٙخ غ٠رىْٛ ئداسح اٌّشبس ٔبدساً ِب

 

 

 

 

 

 

 تذء خطح انًششوع

ٌّغربػذرٕب  اٌّشرشٚع ز١رلجرً اٌجرذء ثزٕف ؾ١عٛ  رضداد اٌؾبعخ ئٌٝ اٌزخةر ذا١وٍّب صاد اٌّششٚع رؼم

ً ١ٍِ ش١اٌزفى ثذْٚ غ٠فٟ اداسح اٌّششٚع، ٚغبٌجب ِب رفشً اٌّشبس ذ١اٌغ ش١ػٍٝ اٌزفى ِشؽٍخ ثرذء  فٟ ب

 بٔربد١ث ١ًأصٕربء رشرى خ١رٚاٌغٙبد اٌشاػ ١ٓاٌّغبّ٘ فٟ اٌزؼش  ػٍٝ ش١اٌزفى غت٠ ش١اٌّششٚع، ؽ

 .خ١ضا١ٔاٌّ ؽزٝ ٚاٌّٛاطفبد اٌّجىشح ٚسثّب ك١اٌزٛص

 )انخطح( إَشاء جذول نهًششوع

ِشرشٚع  ئٔشربء ّىر٠ٓٚ . لا٠ب ؽًرٛٚلزر اٌّششٚع( بٔبد١لبػذح ث) ئٔشبء عذٚي ٌٍّششٚع غزغشق٠لذ 

 -  اٌخةٛاد ئٌٝ أسثغ فئبد ١ُعٍٙخ فٟ ؽبي رمغ مخ٠ثةش

 ئػبفخ اٌّٙبَ . -1

 اٌّٙبَ . ١ُرٕظ -2

 ئػبفخ الأشخبص . -3
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 .ك٠اٌزٛاطً ِغ أػؼبء اٌفش -4

 عرٕزؼش  ػٍرٝ  ش١رفرٟ اٌّشرشٚع ؽ ز٘ب١ررٕف ز٠ُراْ اٌّٙبَ ٘رٟ الأٔشرةخ اٌزرٟ    اضافح انًھاو

 . اٌّٙبَ ٚؽغت ٔٛع ِٗذر ش٠خظبئظٙب ٚرمذ ش١١ئػبفخ اٌّٙبَ ٚرغ خ١ف١و

 ٌرزا  لإداسرٙرب، ت١رػٕرذ ئػربفخ اٌّٙربَ ٌٍّرشح الأٌٚرٝ، فمرذ ل رىرْٛ ثأفؼرً رشر انًھةاو : ىیذُظ

 .ٚٔٛع سثةٙب خ١اٌفشػ ٚاٌّٙبَ ثبعزخذاَ اٌّٙبَ اٌّٛعضح ّٙب١رٕظ خ١ف١اٌزؼش  ػٍٝ و غت٠

 : اٌؼّرً  ذ٠ررش اٌرز٠ٓثؼذ ئػبفخ اٌّٙبَ ئٌرٝ اٌّشرشٚع، فىرش فرٟ الأشرخبص  اضافح الأشخاص

 .Projectفٟ  ١ِٓخزٍف ١ٓٔشبؽ ّ٘ب ١ُِٙٙبَ ئٌ ١١ِٓؼُٙ، ٚرزوش أْ ئػبفخ الأشخبص ٚرؼ

 فرٟ ألرشة  ك٠راٌفش اٌزٛاطً ِغ أػؼبء جذأ٠ِٓ اٌّغزؾغٓ أْ  : كيانرةاصم يغ أػضاء انفش

ٔغرربػ  زؼشلرر٠ًا فمًررذ  ثرربوش ٚلررذ ِّىررٓ ٚئرا ٌررُ ٔمررُ ثٕمررً ِؼٍِٛرربد اٌّّٙررخ ثشررىً ِزىررشس أٚ

 .اٌّششٚع

 

 إداسج يششوػك

أوضرش ِرٓ  ٚلزرب اٌّششٚع، فاداسح اٌّشرشٚع رزةٍرت بٔبد١ػٍّه ثؼذ ئٔشبء عذٚي لبػذح ث زٛلف٠ل 

الٔزٙربء ِٚرب ئٌرٝ  خ٠رربس ش١زغ٠ٚلذ اٌّٙبَ ٚرزُ ئػبفخ الأشخبص  ش١اٌّضبي، رزغ ١ًئٔشبءٖ فؼٍٝ عج

ٌؼرّبْ  شاد١١راٌزمرذَ ٚئعرشاء اٌزغ ٌّشالجرخٚع١ىْٛ ٌذ٠ٕب ورً الأدٚاد  Project ـرٌه ثبعزخذاَ اٌ

 ٔبعؾخ. غخ١ٔز

 

 هييوذُمسى الاداسج انى يا 

 ثرذء  ٚلرذ ١ٓؾ١ثؼرذ ثرذء ِشرشٚػه، عر اَشةاء جةذول انًشةشوع : كيةالاػًةال ػةٍ طش ذؼمة

وّب ٘رٛ ِخةرؾ  اٌؼًّ ؾذس٠ً٘  الأِٛس ِٓ ػذح ٔٛاؽٟ، ِضلا   بد٠ِغش ش١الؽلاع ػٍٝ ع

٘رً  ؟ خ١رضا١ٔاٌؼّرً ػرّٓ اٌّ ِرٓ ؟ ٘رً عرززّىٓ ؟ ً٘ الأشخبص ِزرأخشْٚ ػرٓ اٌغرذٚيٗ ٌ

 ؟ الٔزٙبء خ٠عززّىٓ ِٓ ئٔٙبء اٌؼًّ ثؾٍٛي ربس

 خ٠اٌّشرشٚع ٘رٛ ررأخش رربس ش٠ِرذ ٗٛاعٙر٠ئْ أعٛأ ٚػغ لذ  انةلد انُھائي نهًششوع : ىيذمذ 

 خ٠ٌٍرزؾىُ ثبٌزربس بد١غ١اعرزشار ٚػرغ غرت٠ػٍرٝ اٌغرذٚي، ٌرزٌه  شاد١١رالٔزٙبء ثؼذ ئعشاء رغ

 .ٌٍّششٚع إٌٙبئٟ

 ف؟١٘رً ٔؾزربط ئٌرٝ ػرجؾ اٌزىربٌ ؟ ذ٠رِٓ عذ خ١ضا١ًٔ٘ رغبٚصٔب اٌّ انًششوع : فیاداسج ذكان 

 .ف١ؽً اٌّشبوً اٌّزؼٍمخ ثبٌزىبٌ ( خ١ف١) و ػجؾ خ١فلاثذ ِٓ ػٍّ

 : اْ رؾذد ِٛاػغ اٌّشبوً  غت١ف غ٠رزٛاعذ اٌّخبؽش فٟ وً ِىبْ فٟ اٌّشبس اداسج انًخاطش

 .شح١ٚٔؼبٌغٙب لجً أْ رغجت ٌٕب ثّشبوً وج
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ِشرشٚع  ٌىرً ٚرؼٕٟ وٍّخ ِإلرذ أْ ذح،١ِٕزظ اٚ خذِخ ٚؽ غبد٠٘ٛ اٌغؼٟ اٌّإلذ ل انًششوع :

ػررٓ وررً  ضح١ررِّٚ ِخزٍفررخ اْ إٌّررزظ أٚ اٌخذِررخ ذح١ررِؾررذدح ٚرؼٕررٟ وٍّررخ ٚؽ خ٠ررِؾررذدح ٚٔٙب خ٠ررثذا

 إٌّزغبد الأخشٜ.

 

 صفاخ انًششوع

 -  ثبلرٟ غبص٘ب٠ا ّى٠ٌٓىً ِششٚع طفبد 

 .ٗم١ٌزؾم غؼ٠ٝ٘ذ  ٗ ٌ -1

 ٚلذ ِؾذد ٌٍجذء ٚالٔزٙبء . -2

 ِٙبَ ِؼزّذح ػٍٝ ثؼؼٙب اٌجؼغ . -3

 ِٛاسد ِؾذدح رغزخذَ لإٔغبص اٌّٙبَ . -4

 .( دائُى١ٟٕب٠ِ)د ش١١اٌّششٚع فٟ ؽبٌخ رغ ى١ْٛع -5

 

 يصهس انًششوع

   ػٍٝ عذٌٚخ اٌّششٚع ٕؼىظ٠اٌّششٚع ٚاٌزٞ عٛ   غزغشق٠وُ ِٓ اٌٛلذ  اٌٛلذ. 

 ٌخ٠اٌّرٛاسد اٌجشرش ف١اٌّشرشٚع ٚرٌره اػزّربدا ػٍرٝ رىربٌ ىٍرف٠وُ ِٓ اٌّبي عٛ     ف١اٌزىب 

 . خ٠ٚاٌّبد

 ا٘ذا  ِٚٙبَ اٌّششٚع . خ١وُ ٘ٛ ؽغُ اٌؼًّ اٌّةٍٛة ٌزٍج   اٌّغبي 

 

 

 

 

 

 

 

 

 (1-1ِضٍش اٌّششٚع / شىً )
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 إداسج َطاق انًششوع

 غ٠اٌّشربس لأْ ئداسح ٔةبق اٌّششٚع ٘ٛ أؽذ أُ٘ اٌّٙبساد اٌلاصِخ لإداسح اٌّشرشٚع، ٔظرشًا ؼزجش٠

اٌّشرشٚع  ز١رٌؼرّبْ رٕف ،ٚػجةٙب اٌزؾىُ ثٙب ز٠ُاٌزٟ رزةٍت أْ  شاد١١اٌؾبي ػشػخ ٌٍزغ ؼخ١ثةج

 ً  ٚأطؾبة اٌّظٍؾخ. خ١اٌّؼٕ اٌغٙبد ِغ ١ٌٍٕٗةبق اٌّششٚع اٌّؾذد ٚاٌّزفك ػٍ ٚفمبً

 -: ركش لأھى الأدواخ انري ذساػذ في إداسج َطاق انًششوع هيي ًایف

 اٌّزةٍجربد ١ًرالأػّربي ٚرؾٍ ؼ١ِرٓ خلاٌٙرب رٛػر ز٠ُر خ١رٟٚ٘ ػٍّ يرطهثاخ انًششوع : میذحه 

 . ّٙب١اٌّشاد رغٍ

 َطاق انؼًم محيطش (Scope of Work) : ّٙب١اٌّرشاد رغرٍ رٛػؼ اٌٍّفربد ٚاٌٛصربئك مخ٠ؽش 

 ثبلرفبق ِغ أطؾبة اٌّظٍؾخ .

 ذحكةةى تُطةةاق انًشةةشوع (Scope Control) : أ٘ررُ  رؾىررُ ثٕةرربق اٌّشررشٚع اؽررذٜ ؼزجررش٠

ِزٛلؼرخ  ش١راٌغ شاد١١رٚاٌزغ ش١١رؽغرُ ؽٍجربد اٌزغ ١ًرِٓ رمٍ ٌّٗب رغبّ٘ غ٠ِٙبساد ئداسح اٌّشبس

 اٌّششٚع . رىٍفخ فٟ اٌغذٚي اٌضِٕٟ أٚ شاد١ػٍٝ اٌّششٚع اٌزٟ لذ رإدٞ ٌؾذٚس رأخ

 : ٚاٌؼّررلاء  اٌررذػُ اٌىرربفٟ ِررٓ أطررؾبة اٌّظررٍؾخ ٚفررشق اٌؼّررً انحصةةةل ػهةةى انةةذػى انكةةافي

 .ز١ٖاٌٛالغ ٚرٕف أسع اٌّششٚع ػٍٝ ك١رةج خ١ِٓ ئِىبٔ ذ٠ض٠ِٚذساء اٌّششٚع،  ٠ٓٚاٌّٛسد
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 انفصم انصاَي

 M.S Project 2013واجھح 

& 

 انًششوع راخیضثظ ذةل

 يمذيح

 فرٟ الداسح غربػذ٠ِٓ اٌجرشاِظ اٌّغرزخذِخ فرٟ ِغربي الػّربي فٙرٛ  ٠M.S Projectؼزجش رةج١ك 

 اٌررخ، ِّررب ...ف١اٌّٙرربَ ٚثررذء ٚأزٙرربء الٔغرربص ٚاٌزىرربٌ ذ٠رررؾذ ش١رراٌّشررشٚػبد ِررٓ ؽ ش١عذٌٚررخ عرر

 ز١ُعر ثذلخ ٚثغشػخ، ٕٚ٘ب ١ُِغٍظ اداسح اٌّششٚع ػٍٝ ارخبر اٌمشاس اٌغٍ ( ب١) الداسح اٌؼٍ غبػذ٠

 . M.S Project اٌزؼبًِ ِغ اطذاس

 ضاد١راٌّ ثبلإػربفخ ئٌرٝ ثؼرغ ذح٠اٌغذ ضاد١ِٓ اٌّ ذ٠اٌؼذ ٠M.S Project 2013زؼّٓ أطذاس 

 -  ٠ٍٟاٌّؾغٕخ ٚوّب 

 رّبِرب ذح٠رعذ مرخ٠ثةش اٌمذ٠ّرخاٌّغذٌٚرخ  ش٠اٌزمربس ضح١رProject Reports 2013ِ  ٠غرزجذي  -1

ٚ  Microsoft Excel ِذػِٛرررخ ِرررٓ خ١رررِشئ ش٠اٌزمررربس ٠ٓاٌّشرررشٚع ٚرىرررٛ بٔررربد١ٌزظررٛس ث

Microsoft Visio  ٟ2013فر  Project اٌرٝ ِشربسوخ ِؼٍِٛربد اٌّشرشٚع ِرغ ثبلإػربفخ 

 اٌجشاِظ الأخشٜ .

 Project ٚاعٙخ ١ٓرؾغ ّى٠ٓٚ الأخشٜ . Office  2013مبد١دػُ الإدخبي ثبٌٍّظ ِضً رةج -2

 أٚ اٌّبٚط.( لأٞ ئدخبي ثبٌٍّظ ؾ٠ثشىً أعبعٟ ثبلأٚاِش اٌّٛعٛدح ػٍٝ اٌشش) 

ِرغ  ذ٠رٚررزُ ِشربسوخ ٘رزا اٌّظٙرش اٌغذ خ١بث١اٌّلاؽظخ ػٍٝ اٌٛاعٙخ أوضش أؼرجبؽب ٚأغر ّى٠ٓ -3

 خ١رالأفم خ٠ذ١ٚأخشٜ ِضً الإسشبداد اٌ ذح٠عذ خ١الأخشٜ ثؼٕبطش ِشئ Office  2013مبد١رةج

  Gantt ػشع أششؽخ ِخةرؾ مخ٠ٌةش ب١ٟٔاٌّّزذح ِٓ اٌّّٙخ اٌّؾذدح ػجش عضء اٌّخةؾ اٌج

 ِٓ ٔٛػٙب ثبٌٕغجخ ٌٍّششٚع. ذح٠فشٟٚ٘ 

اٚ  ِؼٍِٛربد ؽرٛي اٌزٛاعرذ ٚػرشع Active Directory اٌّٛسد ِٓ ١ًرفبط شاد١اعز ّى٠ٓ -4

 ثبلإػبفخ Project ئٌىزشٟٚٔ ئٌٝ اٌّٛسد ِجبششح ِٓ ذ٠أٚ ئٔشبء سعبٌخ ثش Lync  ثذء دسدشخ

 Project Backstage فٟ ػرشع SkyDrive ٠ٓئٌٝ ٚؽذح رخض غ٠اٌٝ دِظ اٌٛطٛي اٌغش

2013 . 

أخرشٜ  اٌزبثؼخ ٌغٙربد مبد١ٚاٌزةج خ١اٌٛظبئف الإػبف Office Project 2013 مبد١دػُ رةج -5

 office.microsoft.com/store.  اٌّٛعٛدح فٟ Office Store ٚاٌّزٛفشح ِٓ
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 -  (2-1) ِٓ خلاي ارجبع اٌّغبس الرٟ، وّب ثبٌشىً M.S Project  2013ك١رةج ١ًٌزشغ

Start → All Programs → Microsoft office 2013 → Project 2013 

 

 

 (2-1شكم )

 M . S Project 2013ذشغیم 

اٞ  Blank Project بس١راخز ز١ُرٌ خ١راٌزبٌ ثؼذ اٌؼغؾ ػٍٝ اٌجشٔبِظ اٌّةٍرٛة عرزظٙش ٌره إٌبفرزح

ٔبفرزح خرلاي  ِرٓ ذح٠رأٔشربء ٔبفرزح عذ ّىر٠ٓٚ( 3-1) وّرب ثبٌشرىً ذح٠رعذ Project أشبء ٔبفزح ز١ُع

 -  ٠ٍٟارجبع اٌّغبس اٌضبٟٔ ٚوّب  ثؼذ خ١غ١اٌشئ ك١اٌزةج

(Start → All Programs→ Microsoft office 2013 → Project 2013 → 

Blank Project) 

 (File→ New→ Blank Project)  أو
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 (3-1شكم )

 Projectأَشاء َافزج 

 :.S project 2013M كیيكةَاخ َافزج ذطث

ِٛلؼٙرب ِشاعؼرخ ػرذح فمرشاد، ٌٚلاؽرلاع ػٍرٝ  ِرٓ M.S Project 2013 رزىرْٛ ٔبفرزح ثشٔربِظ

 (4-1اٌشىً )

 ؽغرُ ِٚٛلرغ ٚغٍرك ش١١ر)ررزؾىُ ثزغ اٌرزؾىُ أ٠مٛٔرخِرٓ  زىر٠ْٛ Title Bar : انؼُةةاٌ ظيشش -1

 ك١رٚاعرُ اٌزةج ؾ٠ٌٍشش ١ّٕٟٝٚ٘ ثبٌغٙخ اٌ M.S مبد١رةج خ١فٟ ثم ١ٗوّب ِزؼبس  ػٍ إٌبفزح(

 فرزؼ اٌجشٔربِظ لٚي ِرشح فؼٕرذ ؾ،٠ٚعرؾ اٌشرش ىر٠ْٛٚ اٌشرشٚع( )اعرُ ٠ًراعرُ اٌفبٗ ٚفٟ عبٔج

 ش١ررثغٍررك ٚرىج) رررزؾىُ مٛٔرربد٠ثبلإػرربفخ اٌررٝ أ Project 1 اعررُ اٌٍّررف الفزشاػررٟ ى١ْٛعرر

 . M.S مبد١رةج خ١فٟ ثم ١ٗٔبفزح اٌجشٔبِظ وّب ِزؼبس  ػٍ (ٚغٍك ِإلذ ش١ٚرظغ

 . ٌٍجشٔبِظ خ١غ١اٌشئ جبد٠اٌزجٛ : Tabs Bar ثاخيانرثة ظيشش -2

 .ت٠الٚاِش اٌخبطخ ٌىً رجٛ : Groups Bar انًجًةػاخ ظيشش -3

 ١ًرِرٓ ِؼٍِٛربد فرٟ ؽبٌرخ رفؼ ش٘ب١ٚلذ ِٙبَ اٌّششٚع ٚغ : Timeline انةلد ظيشش -4

 أ٠ؼبص٘ب .

 -ِٓ   زى٠ْٛٚ خ،١اٌّششٚع اٌىٍ ١ًرفبط ٗث ؾذد٠ٚ٘ٛ اٌغضء اٌُّٙ اٌزٞ  : كیيجال انرطث -5

 Database Task  :بٔربد١ادخربي ث ِٗرٓ خلاٌر ز٠ُراٌّششٚع ٚاٌزرٟ  بٔبد١عذٚي لبػذح ث 

 رٌره ِررٓ ِؼٍِٛربد رخرض ورً ِّٙررخ ش١رٚغ خ١رٚاٌفزررشاد اٌضِٕ خ١رٚاٌفشػ خ١اٌّٙربَ العبعر

Task ًٌٍّششٚع وى . 
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  اَةةدجيخطةةظ Gant chart : اٌّشررشٚع، ٚ٘ررٟ ػجرربسح ػررٓ  بٔرربد١ِخةررؾ ٌمبػررذح ث

اٌّشررشٚع ٚرّضررً  بٔرربد١ِررٓ الشررشؽخ ػررّٓ إٌبفررزح اٌّغرربٚسح ٌغررذٚي لبػررذح ث ِغّٛػررخ

 .اٌّٙبَ ١ٓٚرؼةٟ فىشح وبٍِخ ػٓ السرجبؽبد ٚاٌؼلالبد ث ٌٍّٙبَ ة٠ٟثبٌشىً اٌشش

 اٌّشرشٚع اٚ ِخةرؾ بٔربد١ٔبفرزح لبػرذح ث ه٠رٌزؾش ؾ٠شش : Scroll Bar شيانرًش ظيشش -6

 اٌّششٚع .

 غرش١ٜاٌّشرشٚع ٚاٌّزىرْٛ ثبٌغٙرخ اٌ بٔربد١اعرفً لبػرذح ث : Status Bar انحانح ظيشش -7

 ٔرٛع إٌبفرزح ش١١ررغ ّى١ٓفر ّٕر١ٝؽبٌخ اٌّشرشٚع اِرب اٌغٙرخ اٌ ّض٠ًاٌؾبٌخ ٚاٌزٞ  ؾ٠ِٓ شش

 . ش٘ب١ٚرظغ ش٘ب١ٚرىج

 (4-1انشكم )

 M.S Project 2013َافزج

 اٌّشررشٚع ثبلػرربفخ اٌررٝ بٔرربد١ِررٓ عررذٚي لبػررذح ث Project ك١رررزررأٌف ٚاعٙررخ ِغرربي رةج ش١ررؽ

 ِٚررٓ إٌّبعررت،  Gantt chart اٌّخةررؾ اٌضِٕررٟ ٌّغرربس اٌّشررشٚع ٚ٘ررزٖ ِؾررذدح ػررّٓ ٔبفررزح

  -ٚوب٢رٟ   M.S Project ك١ٌزةج اٌّششٚع بٔبد١ؽمٛي عذٚي لبػذح ث ؼ١رٛػ

 : Auto Numberاٌزٍمبئٟ ٌٍّٙبَ ١ُاٌزشل . 

 Indicator v   ثّؾذداد ١ٌٓٛعٛد خةأ ِؼ ١ٗرظٙش اٌّلاؽظبد ٚرٕج ش١اٌّإشش، ؽ Task. 

 Task Mode  ؽج١ؼخ  task 
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 Manually Scheduled   ثبٌٕغجخ ٌٍٛلذ ب٠ذ٠ٚٚاٌغذٌٚخ  بٔبد١اٌج ١ُرٕظ . 

 Auto Scheduled   ب١ٚاٌغذٌٚخ رٍمبئ بٔبد١اٌج ١ُرٕظ . 

 Task Name . اعُ اٌّّٙخ   

 Duration . اٌّذح اٌض١ِٕخ لإٔغبص اٌّّٙخ   

 Start . ربس٠خ ثذء اٌّّٙخ   

 Finish . ربس٠خ أزٙبء اٌّّٙخ   

 Predecessors    ،َاٚاٌغبثمخ خ١رؾذد سلُ اٌّّٙخ اٌزبٌاٌزؼبلت ثبٌّٙب . 

 Resource Name   اعُ اٌّٛاسد اٌّغزخذِخ ٌٍّّٙخ. 

 Add New column   بساد١ررؽغررت الخز ٗٔٛػرر بس١ررٚاخز ذ٠رراػرربفخ ػّررٛد عذ ّىرر٠ٓ 

 . اٌّٛعٛدح ٌٙزا اٌؼّٛد

 Task ت٠رثبٌٕبفرزح اٚ ِرٓ خرلاي رجٛ Task mode ِرٓ ػّرٛد Task ؼرخ١ٌةج ش١١راعرشاء رغ ى٠ْٛ

 ٚوّرب ثبٌشرىً ٚاٌّغّٛػرخ، ت٠رػرّٓ ٔفرظ اٌزجٛ Mode ؼربص٠اٚ ػرّٓ ا Task ِغّٛػخػّٓ 

 Task ؽبٌخ ش١١رغ ؼبصاد٠ا اٌزٛطً اٌٝ ّى٠ٓ right – Click خ٠ٚوزٌه ِٓ اٌمبئّخ اٌضبٔٛ( 1-5)

 . رغزؼًّ ٌٍّٙبَ شح١وض ؼبصاد٠ثبلػبفخ اٌٝ ا

 

 (5-1انشكم )

 Task ؼحیطث شییذغ
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 Setting Project Information:  ضثظ يؼهةياخ انًششوع

 ت٠ررجٛ ِٓ خرلاي ؼبص٠/ ال ١ًرفؼ ّى٠ٓاٌّششٚع ٚ بٔبد١ثأٚلبد لبػذح ث ش١١ثٕبء اٚ رغ خ١رّضً ػٍّ

Project ؼرربص٠ال بس١ررٚاخز Project Information ِررٓ خررلاي ِغّٛػررخ Properties  ٚػٕررذ

 ؽمٛي . رظٙش ٔبفزح ِزىٛٔخ ِٓ ػذح ؼبص٠ال ١ًرفؼ

Start Date  ،Finish Date  ،Current Date (6-1) كًا تانشكم شھایوغ 

 

Project Tab -→ Properties→ Project Information 

 انًششوع راخیضثظ ذةل

 (6-1شكم )

 Start date   ثذء اٌّششٚع خ٠ربس 

 Finish date   أزٙبء اٌّششٚع خ٠ربس 

 Schedule form   ؼربص٠ال بس١رارا وربْ اخز Project start date ٟاٚلربد  ذ٠ررؾذ ؽبٌرخ فر

 Project finish date ؼربص٠ال ىر٠ِْٛٙربَ اٌّشرشٚع ثبٌٕغرجخ ٌجرذء اٌّشرشٚع ٚ بٔربد١لبػذح ث

 ؼربص٠ال بس١راخز ز١ُرأزٙربء ٚلرذ اٌّٙربَ ف ذ٠راٌؼًّ ػٍٝ اعبط رؾذ بس١ِفؼً، أِب ارا رُ اخز ش١غ

Project finish date  ؼبص٠ال ى٠ْٛفؼٕذئز Project start date ِفؼً ش١غ . 

 Current Date   اٌؾبٌٟ خ٠اٌزبس . 
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 Status date   بد،١الؽظرربئ خ٠ثبٌٕغررجخ اٌررٝ ررربس خ٠٘ررزا اٌزرربس ؼررذي٠اٌؾبٌررخ، ٚ خ٠ررربس 

ثبلإػرربفخ اٌررٝ  ٗاعررزخذاِ ١ِٓةجررك ٌؾرر ش١رراٞ غ Non Available (NA) فؼرر٠ًٚ

 . ثؼذح ؽشق اٌّششٚع بٔبد١ٌؼشع ٔبفزح لبػذح ث ؼبصاد٠ِغّٛػخ ِٓ ا

 Calendar   ِٙبَ اٌّششٚع ٠ُاؽذ أٛاع رمٛ بس١اخز  -  

- Hours 24    ًّطجبؽٟ، ِغبئٟ( ٚعجبد اٌؼًّ /) عبػخ 24عبػبد اٌؼ. 

- Night Shift    َا١ٌٍٍٟعبػبد اٌذٚا (5PM - 12 PM .) 

- Standard   ٚعجخ اٌؼًّ اٌظجبؽٟ) خ٠بد١عبػبد اٌؼًّ الػز (AM - 5 PM / 8.) 

 Priority    ؾرذد٠ٚ( 0 – 1000) ١ٓثر ٌٍّشرشٚع ٚرؾرذد ِربرّضً ػذد اٌّٙربَ اٌزرٟ رؾرذد 

 ( ِّٙخ .500ـ )سلُ افزشاػٟ ٌؼذد اٌّٙبَ ث

  ك٠اٌّششٚع ػٓ ؽش بٔبد١اْ ٔظً اٌٝ ٔفظ ِؼٍِٛبد اٚلبد لبػذح ث غ١وزٌه ٔغزة

File → Info 

 يؼهةياخ انًششوع

(1-7) 

   ؾرذد١ٌ Advanced صرُ ٔخزربس  Project Information ٌٍّششٚع ِرٓ خ١ف٠ِؼٍِٛبد رؼش ذ٠ٌزؾذ

 ٚاعُ اٌشرشوخ Manager اٌّششٚع ش٠اعُ ِذ Subject ٔٛع اٌّششٚع،  Title اٌغذٚي ػٕٛاْ)

Company بٔرربد١ِٕشررٟء لبػررذح ث بس١ررٚؽغررت اخز ؼرربؽٙب٠ا ز٠ُرراٌزررٟ  ١ًِررٓ اٌزفبطرر (ش٘ررب١ٚغ 

 اٌّششٚع.

File → Info→ Project Information → Advanced Properties→ Summary 
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 نهًششوع حیفييؼهةياخ ذؼش

 (8-1انشكم ) 

  Project Working Time ػًم انًششوع راخیذةل

 ارّبِٙرب ؽبٌخ اٌّششٚع ٚاٌٛاعرت لائ٠ُػًّ اٌّششٚع ٚفك ِب  زبد١رٛل ٠ًثٕبء اٚ رؼذ خ١رؼزجش ػٍّ

 -  ٚوبلرٟ ادخبي ِؼٍِٛبد اٌّٙبَ ٚاٌّٛاسد ٕٚ٘بن ػذح ؽبلد خ١لجً ثذء ػٍّ ؼ١ثشىً طؾ

 :  Create New Time ذيتُاء ولد جذ -1

Project→ Properties→ Channing Working Time→ Create New Calendar 
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 انًششوع راخیتُاء ذةل

 (9-1شكم )

ادخربي  ّضر٠ًٚ Name ػٍرٝ ؽمرً  Create New Base calendarِشثرغ اٌؾرٛاس ؾز٠ٞٛ ش١ؽ

 -  خ٠بس١رٌه ؽمٛي اخز ٠ٍٟصُ  ٠ٌٍُزمٛ ذ٠اعُ عذ

 الٚي بس١الخز Create New Base Calendar  - ٛثبٌىبًِ. ذ٠عذ ٠ُرمٛ ٠ٓرى 

 اٌضرربٟٔ بس١ررالخز Make a copy of  - ٛؾ١الطررٍٟ ٚػٕررذ رخةرر ٠ُػّررً ٔغررخخ ِررٓ اٌزمرر 

 صررلاس ٌٍّشررشٚع ٚاٌزررٟ رىررْٛ ػٍررٝ خ١رر١ِٛاؽررذ أررٛاع عرربػبد اٌؼّررً اٌ ذ٠رررؾذ غررت٠اٌّشررشٚع 

  - أٛاع

 Hours 24    ًّعبػخ 24عبػبد اٌؼ. 

 Night Shift    ١ٍٟاٌؼًّ اٌٍعبػبد. 

 Standard   (. عبػبد 8)  خ٠بد١عبػبد اٌؼًّ الػز 

 

اٚ اؽزغربة )ل١ربط  Setup Colander of the Project ػًم انًششوع ذةلیراخ شییذغ -2

 -  (خ١اٌؼًّ اٌفؼٍ -فزشح 

 خ١راٌٛؽٕٚ خ١ر٠ٕاٌذ بد١ر)الػ خ١ٚاٌشعرّ خ١اٌؼًّ ٚالعبصاد العرجٛػ ذ١ٔؾذد فٟ ٘زٖ اٌّشؽٍخ ِٛاػ

 غرت٠أشبء ِخةؾ ِشرشٚع  فؼٕذ (( خ١فزشح اٌؼًّ اٌفؼٍ بط١) لٚؽغت اٌذٌٚخ( ٚثزٌه ٔزّىٓ ِٓ )

 (( خ١ر٠ٕاٌذ- خ١ر)) اٌٛؽٕ خ١ٚاٌشعرّ خ١العرجٛػ اٌؼةً ب٠َا ذ٠ٚاٚلبرٙب ٚرؾذ خ١اٌؼًّ اٌفؼٍ ب٠َا ذ٠رؾذ

فرٟ اٌشرشق  ّٕرب١اٌغرجذ ٚالؽرذ ث ب٠َرفرٟ ا خ١العرجٛػ اٌؼةرً ب٠َاٌّزؾذح رىْٛ ا بد٠فّضلا فٟ اٌٛل

 ز٠ُراٌؼةرً ٚ ب٠َرا ذ٠رالٔزجربٖ ػٕرذ رؾذ غرت٠ٚثشرىً ػربَ  اٌغّؼرخ ٚاٌغرجذ ب٠َرالٚعؾ فزىرْٛ فرٟ ا
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اٌؼةررً  ذ٠ررِّٙررخ ٌزؾذ ٠ٓبس١ررخ ٛعررذ٠اٌّشررشٚع، ٚ زرربد١رٛلٌؼررجؾ  Project ت٠ررالعررزؼبٔخ ثزجٛ

 -  خ١اٌشعّ ش١ٚغ خ١اٌشعّ

Exception -1 :- 

 (( خ١ررٚاٌٛؽٕ خ١رر٠ٕاٌؼةررً اٌذ -اعررُ اٌؼةٍررخ اٚ إٌّبعررجخ )) العررزضٕبءاد ؼرربص٠رررذسط ثٙررزا ال ش١ررؽ

 -  ثبٌّغبس الرٟ ٍٙب١رفؼ ز٠ُوّب  ؼبص،٠ثؾمٛي اٌغذٚي اٌخبص ثبلإ خٙب٠ٚربس

Project→ Properties→ Change working time→ Exception 

 اوضرش وّرب ١ًرفبطر ؼربص٠أْ ٔؾرذد ِرٓ خرلاي ٘رزا ال ّىر٠ٓ ٕٙب١ؽ Detail ؼبص٠ال ١ًرفؼ ز٠ُػٕذ٘ب 

 ػّررً ٚ٘ررٛ ٠َٛرر** ) ٗ ثرر ىرر٠ْٛاٚ  ػةٍررخ ( ٠َٛرر* ) ذ٠رررؾذ ١ًِٚررٓ ٘ررزٖ اٌزفبطرر( 9-2) ثبٌشررىً

 ( خ٠اٚ عررٕٛ خ٠شررٙش خ،١أعررجٛػ خ،١رر٠ِٛ)  ٔرٛع اٌؼةٍررخ ذ٠ررػةٍررخ ( ثبلإػرربفخ اٌررٝ رؾذ ٠َٛرر ذ٠رثبٌزؾذ

 -  رزجغ اٌّغبس ادٔبٖ ٚثؾغت

Project→ Properties → Change working time→ Exception → Details 

Nonworking* 

working times** 

 

 

 

 

 

 

 

 

 

 

 

 (9-2شكم )

 انؼطم وانؼًم اشُاء انؼطم اويا ذيذحذ
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Work Week -2 :- 

 ١ًرفؼ ز٠ُ ؼبص٠ال بس١ٚػٕذ اخز خ١اٌؼًّ اٌفؼٍ ب٠َالعجٛع ٚا خ٠ػةٍخ ٔٙب ذ٠ٌزؾذ ؼبص٠٘زا ال غزخذ٠َ

Details  ،رزجررغ اٌّغرربس ( ٚػٕررذ 9-3) ِّٙررخ ٚوّررب ِٛػررؼ ثبٌشررىً بساد١ررػٕررذ٘ب رظٙررش صررلاس خ

 -  اٌزبٌٟ

Project→ Properties→ Change working time→ Work Weak→ Details 

 (9-3انشكم )

 حیانؼًم انفؼه اويالاسثةع وا حياحرساب ػطهح َھا

اٌشربًِ   ذ٠راٌزؾذ ٗفزر١ٚاٌزٟ رىْٛ ٚظ Options ؼبص٠ا Change working time ٔغذ فٟ ٔبفزح

اعرشاء  ثبلإِىربْ اٌرٝ ثبلإػربفخالعرجٛع ٚاٌشرٙش  َٛ،١ثبٌ ٗث جذأ٠ٌجذء اٌؼًّ اٌفؼٍٟ ٌٍّششٚع اٌزٞ 

 -  الرٟ اٌّغبس ارجبع غت٠ ؼبص٠ال ١ً....اٌخ، ٌٚزفؼالفزشاػ١خثغبػبد اٌؼًّ  ش١١رغ ػ١ٍّخ

Project→ Properties→ Change working time → Options 
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 (9-3انشكم )

 انشايم نثذء انؼًم انفؼهي نهًششوع ذيانرحذ

شربًِ  ذ٠ررؾذ خظر٠ّٓٚورً ِرب  ضاد١رلأٚلبد ِٚ شح١وض ذاد٠ٕ٘بن رؾذ( 9-3) ثبٌشىً لاؽظ٠وّب 

 -  ثؼؼب ِٕٙب ٠ٌٍٟجذء اٌؼًّ اٌفؼٍٟ ٌٍّششٚع ٚوّب 

 Week start on   العجٛع ٗث جذأ١اٌزٞ ع ١َٛاٌ ذ٠رؾذ ّى٠ٓ. 

 Fiscal year start in   عٕخ اٌؼًّ ٗث جذأ١اٌشٙش اٌزٞ ع ذ٠رؾذ. 

 Default start time   ٌ١ِٟٛٚلذ ثذأ اٌؼًّ ا. 

 end time   ٌ١ِٟٛٚلذ أزٙبء اٌؼًّ ا. 

 Hours per day   ٌخ١ِٛ١ػذد عبػبد اٌؼًّ ا. 

 Hours per week   خ١ػذد عبػبد اٌؼًّ العجٛػ. 

 Hours per month   ػذد عبػبد اٌؼًّ فٟ اٌشٙش اٌٛاؽذ. 
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 خ١) ػٍّ ٚاٌزٟ رّضً ِٚؼٍِٛبد اٌّششٚع ( زبد١ٌىً رٛل ش١١ٚرغ اعزؾذاس)  اٌؼشٚسٞ خضِْٓ 

 -  ػًّ اٌّششٚع ٚرىْٛ ثؼذح ؽبلد ؼخ١ٚاِزذاد ثّب رلائُ ؽج غ١(. ٚثؼذح ط ١ٍِٓف ِؼ خضْ

 Save  ثبٌخضْ اصٕبء اٌؼًّ ؼب٠ا ؼبص٠٘زا ال غزخذ٠َِشح ٚ لأٚيخضْ اٌٍّف . 

File → Save 

Save As  ْالطٍٟ اٌزٞ  اٚ خضْ ِٛلغ أخش ٌٍّٛلغ ش٠ِغب ثبعُخضْ اٌٍّف لأٚي ِشح اٚ اٌخض

 .٠ًاٌفب ٗخضْ ث

File → Save As 

 M . S project اَةاع انًهفاخ او الايرذاداخ نثشَايج

 Pdf   ٍِفبد رظذس ٌٍششوبد ِؾزٛا٘ب ش١١رغ غ١ٌٚىٓ ل ٔغزة ) طٛس ( ٚصبئك (.) 

 Mpp .ٚصبئك   

 XmL   ِغ اوضش ِٓ ثشٔبِظ ِضًٗ اعزخذاِ ّى٠ٓ (Excel.) 

 Mpt .لٛاٌت   

 

 انفصم انصانس

 طشق ػشض لاػذج تیاَاخ انًششوع

 أشكال طشق انؼشض 

ٚف١ٗ رفبطر١ً وض١رشح ، عرٛ  رىرْٛ اٌؾبعرخ ئٌرٝ  Projectػٕذ أٔشبء ِششٚع ِؼ١ٓ ػّٓ رةج١ك 

ئعشاء رغ١١شاد ٚئػبفبد ػٍٝ ٔبفرزح اٌزةج١رك ثبلإػربفخ ئٌرٝ رٛػر١ؼ ئٌرٝ رٛػر١ؼ ؽرشق ػرشع 

ِرٓ أػربفخ ٚئعرشاء رغ١١رشاد ِؼ١ٕرخ  Taskِٚؼشفخ ؽج١ؼخ اٌزؼبًِ ِغ اٌّٙبَ  Projectاٌّششٚع 

 -ٌٚزٌه عٛ  ٔمَٛ ثزٛػ١ؾٙب ٟٚ٘ وب٢رٟ  

 Ganttح يخطظ أولاً / ذغییش يساح

، ٌٚزغر١ًٙ  Gantt Chartػٕذ أٔشبء ِششٚع ٠ؾزبط ئٌٝ سؤ٠خ ٚاػرؾخ ٌٍج١بٔربد ٌٚشعرُ ِخةرؾ 

  -ٟٚ٘ وب٢رٟ   Ganttسؤ٠خ ِخةؾ اٌّششٚع ٠ّىٓ ئعشاء رغ١١ش ثّغبؽخ ِخةؾ 

  رج٠ٛت ِٓView  ٠زُ اخز١بس ِغّٛػخZoom  ٚاٌزٟ ٠ّىٓ ِرٓ خلاٌٙرب رىج١رش ٚرظرغ١ش ٔبفرزح

Gantt Chart   ٓوّب ِٛػؼ فٟ اٌّغبس٠ٓ الر١١-  

         View bars      →      Zoom     →     Zoom in Ganttذكثیش يساحح 

   Zoom out Ganttذصغیش يساحح            
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 (11-3شكم )

 يثاخثةيٍ انر Ganttذكثیش وذصغیش يساحح 

  ٠ّىٓ اعشاء رغ١١شZoom  شرش٠ؾ اٌؾبٌرخ ِٓStatus bar  ، َ٠ٚىرْٛ أعرًٙ ثبٌٕغرجخ ٌٍّغرزخذ

ع١زُ رغ١١ش فٟ ِخةؾ لبػذح ث١بٔبد اٌّشرشٚع ٚ٘رٛ  Zoomٚػٕذ اعشاء اٌزغ١١ش ثزفؼ١ً اٚاِش 

 (.Ganttِم١بط اٌّٙبَ )ِخةؾ 

 

 

 

 

 (4-1شكم )

 يٍ ششيظ انحانح Ganttذكثیش وذصغیش يساحح يخطظ 

 Project Viewشاَیاً / طشق ػشض انًششوع 

ثبلإػربفخ اٌرٝ ػرذح ا٠ؼربصاد  ٠Gantt Chartزُ ػشع لبػذح ث١بٔبد اٌّششٚع أٚ ِخةرؾ عبٔرذ 

ٚغ١ش٘رب ِرٓ ال٠ؼربصاد ِرٓ  Calendarؽش٠مخ اٌزم٠ُٛ  Network Chartِضً ػشع اٌشجىبد 

ؽ١ش رىْٛ ػٍٝ ١٘ئخ سعَٛ   Status Barاٚ ِٓ شش٠ؾ اٌؾبٌخ  View  &Taskخلاي رج٠ٛجبد 

 -( ٚوب٢رٟ  4-1وّب فٟ اٌشىً ) Zoomثغبٔت ا٠ؼبص 

  ٠ّىررٓ ػررشع ِخةررؾGantt Chart   ُٚغ١ش٘ررب ػررّٓ خررلاي اٚ ػررشع شررجىٟ اٚ اٌزمرر٠ٛ

( ، ثبلإػبفخ اٌٝ ئ٠ؼبصاد اخشٜ ٠زُ اٌزةشق ٌٙرب 4-2وّب فٟ اٌشىً ) Task Viewِغّٛػخ 
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ٔزجرررغ اٌّغررربس ادٔررربٖ ٚ٘ىرررزا ٌجم١رررخ ال٠ؼررربصاد ػرررّٓ  Ganttفّرررضلاً ٌؼرررشع ِخةرررؾ لؽمررربً ، 

  -اٌّغّٛػخ  

 

 

 

 

 

 (4-2شكم )

 Viewذفؼیم ايؼاصاخ ذثةية 

  ذثةية Task 

، ؽ١رش رظٙرش لبئّرخ ِٕغرذٌخ رؾرٛٞ ِغّٛػرخ  Taskػرّٓ رج٠ٛرت   ٠Viewزُ اخز١بس ِغّٛػرخ 

ا٠ؼرربصاد ػررشع إٌٛافررز اٌخبطررخ ثرربٌزةج١ك ، فّررضلاً ٌؼررشع ِخةررؾ اٌّشررشٚع ٠ررزُ اٌزأشرر١ش ػٍررٝ 

ٚثزٌه ٠زُ رفؼ١ً ٘زا ال٠ؼبص ٌؼشع ٔبفزح ِخةؾ اٌّششٚع ٚوّب ثبٌّغبس  Gantt Chartال٠ؼبص 

  -ا٢رٟ  

Task     →         View     →      Gantt Chart 

 

 

 

 

 

 

 

 

 

 (4-3شكم )

 Taskذفؼیم ايؼاصاخ ذثةية 
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 Sort and filtering for Tasksشانصا / ػشض وذشذیة وذصفیح يھاو انًششوع 

٠ّىٓ ػشع ٚرظف١خ ِٙبَ اٌّششٚع ؽغت رشر١ت ٔٛع ِؼ١ٓ ٚرشرت ثم١رخ اٌّٙربَ ػٍرٝ أعبعرٙب ، 

رظررف١خ ٚػررشع ( ٠ّٚىررٓ أعررشاء 5-3وزشر١ررت ؽغررت اٌؾررش  ِررضلا ٚوّررب ِٛػررؼ فررٟ اٌشررىً )

 -اٌج١بٔبد ٚوّب ٠ٍٟ  

  ذثةيةView 

)إٌررٛع اٌخرربص ثبٌزشر١ررت اٌّةٍررٛة( وزشر١ررت لبػررذح  Sortال٠ؼرربص  Dateاخز١رربس ِررٓ ِغّٛػررخ 

ث١بٔرربد اٌّشررشٚع ؽغررت ررربس٠خ ثررذء أٚ أزٙرربء اٚ ؽغررت ال١ّ٘ررخ اٚ ؽغررت اٌىٍفررخ اٚ ؽغررت سلررُ 

اٌزغٍغً اٚ اٌزشر١ت اٌزظبػذٞ ٌلأؽرش  الثغذ٠رخ ٚ٘ىرزا ، ٌٚزفؼ١رً رشر١رت اٌج١بٔربد ِرضلا ؽغرت 

ثم١خ ال٠ؼربصاد ٔفرظ اٌّغربس ثربخزلا  ّٔرؾ  ٚلذ ثذء اٌّٙبَ ٠غت ارجبع اٌّغبس أدٔبٖ ، ؽ١ش رأخز

  -اٌزشر١ت ٚوب٢رٟ  

View Bar    →      Date    →     Sort     →     by Start date 

 (5-3شكم )

 ذشذیة انثیاَاخ يٍ انرثةية

 By Start date :- . َرشر١ت اٌّششٚع ؽغت ربس٠خ ثذء اٌّٙب 

 By Finish date  -  أزٙبء اٌّششٚع .رشر١ت اٌّششٚع ؽغت ربس٠خ 

 By Priority  - . َرشر١ت اٌّششٚع ػٍٝ أعبط أ١ّ٘خ اٌّٙب 

 By Cost  - . َرشر١ت اٌّششٚع ػٍٝ أعبط وٍفخ اٌّٙب 

 By ID  -  ًرشر١ت اٌّششٚع ػٍٝ أعبط رغٍغTask . 
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 ِرٓ خرلاي أػّرذح  رفؼ١ً أ٠ؼربص رشر١رت اٌج١بٔربد رظربػذٞ أٚ رٕربصٌٟ ؽغرت الأؽرش  الأثغذ٠رخ

ٌرجؼغ ٔٛافرز لبػرذح اٌج١بٔربد ، فّرضلاً رشر١رت لبػرذح  ثبلإػربفخعذٚي لبػرذح اٌج١بٔربد اٌّشرشٚع 

، عرٕلاؽظ ٌىرً ػّرٛد ٠ٛعرذ أ٠ؼربص  Gantt chartث١بٔبد اٌّششٚع ٠ىْٛ ػّٓ ٔبفزح ِخةرؾ 

  -اٌزشر١ت اٌخبص ٌج١بٔبد اٌؼّٛد ٚػٕذ٘ب عزشرت ثم١خ اٌّٙبَ ٚوّب ثبٌشىً أدٔبٖ  

 

 

 

 

 

 

 (6-3شكم )

 ذشذیة حسة الأحشف يٍ أػًذج لاػذج تیاَاخ انًششوع

 

 انفصم انشاتغ

 M.S Projectأوايش وايؼاصاخ ذُسیك 

ِغ ث١بٔبد ِشرشٚع فٍرزٌه ٠زٛعرت  اْ ػ١ٍّخ أدخبي اٌج١بٔبد رىْٛ ِّٙخ ِٚزشؼجخ فٟ ؽبٌخ اٌزؼبًِ

لبػررذح ث١بٔرربد اٌّشررشٚع اٌزؼبِررً ِررغ ا٠ؼرربصاد ِررٓ ػررّٕٙب ا٠ؼرربصاد رخررض اٌزٕغرر١ك  ػٍررٝ ِٙرر 

الأخررشٜ ِٚررٓ ٘رررزٖ   M.S officeٚاٌزٕؼرر١ذ ٚغ١ش٘ررب ِررٓ ال٠ؼررربصاد اٌّشررزشوخ ِررغ ثررشاِظ 

 -ال٠ؼبصاد وبلرٟ  

 Fileذثةية  -1

 Info    ِؼٍِٛبد رخض اٌّششٚع 

 New  أٔشبء ِششٚع عذ٠ذ   

 Open ْٚاعزذػبء فب٠ً ِخض   

 Save ْخض   

 Save As ُخضْ ثبع   

 Print اٌةجبػخ   
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 Share اٌّشبسوخ   

 Export رخضْ ٠ٚشعً اٌفب٠ً )رظذ٠ش( ػٍٝ أعبط ط١غ ِخزٍفخ   

 Close غٍك دْٚ اٌخشٚط ِٓ اٌجشٔبِظ   

 Account  ؽغبة ثشٔبِظ  M.S Project 

 Options  خ١بساد   

 

 Taskذثةية  -2

  ػّٓ ِغّٛػخClipboard 

- Cut لض 

- Paste ٌظك 

- Format Painter ٔغخ رٕغ١ك 

  ػّٓ ِغّٛػخFont 

- Font ٔٛع اٌخؾ 

- Font Size ؽغُ اٌخؾ 

- B ئػةبء عّه اٌخؾ   

   خؾ ِبئً / -

- U  رؾذ٠ذ خؾ أعفً اٌىٍّبد 

- A رظ١ًٍ ٌْٚٛ اٌخؾ 

 

ؽ١ش رؾٛٞ ِغّٛػخ ِٓ ال٠ؼبصاد اٌزٟ ٠ّىٓ أْ رؼب  أٚ رٍغٝ  -يُطمح انرشغیم انسشيغ : -3

 (7-3)اٌّششٚع ٚوّب ِٛػؾخ ثبٌشىً  ٚؽغت ِٙ 
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 (7-3انشكم )

 انرشغیم انسشيغ لإيؼاصاخ انرُسیك

( ِغّٛػرخ ا٠ؼربصاد ِرٓ ػرّٕٙب ادساط 7-3ٚوّب ِٛػرؼ ثبٌشرىً ):  Right – Clickَافز  -4

  Propjetٚؽز  ثبلإػبفخ ئٌٝ ال٠ؼبصاد العبع١خ ٌؼًّ رةج١ك 

 Cut Cell  لض خلا٠ب   

 Copy Cell ٔغخ   

 Paste ٌظك   

 Insert Cell  أػبفخ خ١ٍخ   

 Delete Cell ؽز  خ١ٍخ   

 Past Special ( ٌٝأسعبي اٌّششٚع ئ  HTML )ِضلا 

 Insert Task َادساط ِٙب   

 Delete Task َؽز  اٌّٙب   

 Inactivity Task ًاٌغبء اٌزفؼ١   

 Clear Contains ؽز  اٌّؾز٠ٛبد   
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 (8-3شكم ) 

 Right - Clickَافزج 
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 انفصم انخايس

 ذطثیك )انًششوع انةھًي( –لاػذج تیاَاخ انًششوع 

 (9-3انشكم )

 يششوع تید وھًي

ثؼذ رخة١ؾ اٌّششٚع ِٓ اٌؼشٚسٞ أٔشبء لبػذح ث١بٔبد ٌىً ِٙبَ اٌّششٚع ٚاٌزٟ رؼُ )العُ ، 

اٌزؾذ٠رذاد اٌؼرشٚس٠خ اٌزرٟ ل ٠ّىرٓ العرزغٕبء فزشح أٔغبص ، ٚلذ ثرذء ، ٚلرذ أزٙربء )رؼزجرش ِرٓ 

 ػٕٙب ( ، اٌزؼبلت ، اعُ اٌّٛسد( .

٠ّٚىٓ اػربفخ أػّرذح عذ٠رذح ٚؽغرت ِرب ِخةرؾ ٌرٗ ِرٓ رفبطر١ً ٌٍّشرشٚع ٚ٘رزا ِرب  Taskٌٚىً 

 . ٠M.S Projectٛفشٖ رةج١ك 

 Tasksأَشاء وذؼذيم انًھاو 

  اٌّٙبَ اٌشئ١غ١خSummary Tasks 
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  اٌّٙبَ اٌفشػ١خSub Tasks 

)أٞ  Selectٌىٟ ٔمغُ اٌّٙبَ ئٌٝ ِٙبَ فشػ١خ ٠زُ رٌه ػٓ ؽش٠ك رؾذ٠ذ )رظ١ٍرً( اٌّٙربَ ثٛاعرةخ 

( ، ػٍٝ ألغبَ اٌّٙربَ 11 -3ِٓ خلاي اٌغؾت ٚالإفلاد ثضس اٌفأسح الأ٠غش( وّب ِٛػؼ ثبٌشىً )

أٚ أ٠ؼرربص  indent Taskٚٔخزرربس الِررش  Scheduleصررُ ِررٓ ِغّٛػررخ  Taskصررُ ٔخزرربس رج٠ٛررت 

outdent task . ٚاٌزٞ ٠ؼ١ذ اٌّٙبَ اٌفشػ١خ ٌزىْٛ سئ١غ١خ 

 

 

 

 

 

 

 

 (11-3شكم )

  ذحذيذ انًھاو انشئیسیح وانفشػیح
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فؼٕذ غٍك ِإلذ ٌّّٙرخ أعبعر١خ ِؼ١ٕرخ ٌزم١ٍرً ِغربؽخ سؤ٠رب ثم١رخ اٌّٙربَ عرٛ  رٕغٍرك ِؼٙرب اٌّٙربَ 

  -اٌفشػ١خ اٌزبثؼخ ٌٙب ٚوّب ِٛػؼ فٟ اٌشىً أدٔبٖ  

 

 

 

 

 

 

 

 

 (4-1شكم )

 غهك يؤلد نًھاو انًششوع

أِب ارا اسدٔب أٔشبء ِّٙخ  سئ١غ١خ ف١زُ رٌه ػٓ ؽش٠ك اخز١ربس ِٛلرغ اٌّّٙرخ اٌّةٍرٛة أٔشربئٙب ِرٓ 

صررُ الِررش  Taskخررلاي رظ١ٍررً اٌّٙرربَ اٌّةٍررٛة أْ رىررْٛ ِٙرربَ فشػ١ررخ ٌٙررب صررُ اخز١رربس اٌزج٠ٛررت 

Summary .ٚثؼذ رٌه ٔمَٛ ثزغ١ّخ ٘زٖ اٌّّٙخ اٌشئ١غ١خ 

ِشؽٍخ رضج١ذ اٌّٙبَ اٌشئ١غ١خ ٚاٌّٙبَ اٌفشػ١رخ ٠غرت الٔزجربٖ ئٌرٝ أِرٛس ِّٙرخ ٚاٌّشربس أ١ٌٙرب  ٚثؼذ

 -( ، ٚوب٢رٟ  4-2ثبٌشىً )

٠زُ رؾذ٠ذ ِذح الإٔغبص ٌىً ِّٙرخ ٚرّضرً ِرذح الٔغربص اٌّغرزغشلخ )اٌّزٛلؼرخ( لإوّربي ورً ِٙربَ  -1

 ٚرؾذد ؽغت اٌخجشح اٌغبثمخ أٚ ثؼذ اعزشبسح ِخزظ١ٓ .

ذ٠ررذ ِررذح الٔغرربص فمررؾ عررزظٙش أشررشؽخ ص١ِٕررخ ِررٓ اٌةررش  الأ٠غررش ٌٕبفررزح ِخةررؾ فررٟ ؽبٌررخ رؾ -2

اٌّششٚع ٟٚ٘ رٛػ١ؼ صِٕٟ ٌفزشح أغبص اٌّّٙخ ٚاٌّؾذدح ػٕذ عذٚي لبػذح ث١بٔبد اٌّششٚع 

ٚرىْٛ ػٍٝ شىً أششؽخ غ١ش ِؾذدح الؽشا  ٔز١غخ ػذَ  Gantt chartٚاٌزٟ رغّٝ عبٔذ 

 رؾذ٠ذ ٚلذ ثذء ٚأزٙبء اٌّٙبَ .

اٌٝ شىً خؾ ِغزم١ُ ِغٍرك الؽرشا  فرٟ رزغ١ش شىً الششؽخ اٌض١ِٕخ )ٌٍّٙبَ اٌشئ١غ١خ فمؾ(  -3

 . Auto Scheduleؽبي رغ١١ش ؽج١ؼخ اٌّٙبَ ئٌٝ 

ِٓ اٌُّٙ عذاً رؾذ٠ذ ٚلذ ثذء وً اٌّٙبَ ، ػٕذ٘ب عٛ  ٠زغ١ش ِٛلغ اٌشرش٠ؾ اٌضِٕرٟ رجؼربً ٌجرذء  -4

 اٌّّٙخ.
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 أٚي ِّٙخ فشػ١خ ئٌٝ ؽ١ٓ أزٙبء وً اٌّٙبَ اٌفشػ١خ ٌٗ . دائّبً اٌّشؽٍخ الأعبع١خ رجذأ ِٕز ثذء -5

 (4-2شىً )

 رضج١ذ ِٙبَ اٌّششٚع

 Splitting Tasksذمسیى انًھاو 

رمغُ اٌّشبس٠غ فٟ ثؼغ الؽ١بْ ، ٚرٌه ػٕذِب رجذأ اٌّٙبَ صرُ ٠غرت ٚػرؼٙب فرٟ الٔزظربس لجرً أْ 

ٚاعٙذ أغلاق اٌؼًّ إٌبعُ ػٓ رزّىٓ ِٓ اٌجذء ِشٖ أخشٜ فٟ ٚلذ لؽك ، ػٍٝ عج١ً اٌّضبي ارا 

ِفبٚػبد اٌؼّرً أٚ ٠ٛعرذ ٠رَٛ ػبطرف ِّٚةرش عرذاً ٌٚرُ ٠غرزة١غ اٌؼّربي ِرٓ اٌّغرٟء ِؼٕربٖ أٔرٗ 

 ٕ٘بٌه لةغ فٟ ٚلذ اٌؼًّ فلا ثذ ِٓ رمغ١ُ اٌّٙبَ .

وّرب  Splitصرُ الِرش  Scheduleصُ ٔخزبس اٌّغّٛػخ  Taskرٌه ػٍٝ اٌّٙبَ ٔمَٛ ثبخز١بس ٌٚؼًّ 

 -٢رٟ  ِٛػؼ فٟ اٌشىً ا
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(3-4) 

 ذمسیى انًھاو

سح فٕخزبس اٌّّٙخ اٌّشاد رمغ١ّٙب ِٓ خلاي خةرٛؽ ٚلرذ ٠زفؼً ِإشش اٌفأ Splitثؼذ اخز١بس الِش 

اٌّّٙخ فٕؼغؾ ػٍٝ خؾ اٌّّٙخ ِٓ اٌٛلذ اٌّةٍٛة رؼة١ٍٗ ئٌٝ اٌٛلرذ اٌغذ٠رذ ٌٍجرذء اٌغذ٠رذ ٌٙرزٖ 

 -اٌفأسح الأ٠غش ، ٚوّب ِٛػؼ فٟ اٌشىً أدٔبٖ اٌّّٙخ )اٞ ِٓ خلاي اٌغؾت ٚالفلاد ثضس 

 (4-4شكم )

 ػًهیح انسحة والافلاخ

 -ثؼذ الفلاد اٌفأسح عزضجذ ػ١ٍّخ اٌزمغ١ُ ١ٌىْٛ شىً خةٛؽ اٌٛلذ ٌٍّّٙخ ثبٌشىً ادٔبٖ  
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 (4-5انشكم )

 ذمسیى ولد انًھًح

 Milestonesذحذيذ حذوز يشحهح اَرھاء 

٠ش١ش ئٌٝ أزٙبء ِشؽٍخ ِؼ١ٕخ ٚػبدح ِرب رؼرب  ئٌرٝ ثبسصح )ؽذٚس أٚ فؼً(  ٟ٘ ػجبسح ػٓ ِؼبٌُ

ٔٙب٠خ ِشؽٍخ ٌٍذلٌخ ػٍٝ اوزّبٌٙب ٚرىْٛ ِذح ٘زٖ اٌّؼبٌُ طفش ، ٠ّٚىٓ أٔشبء اٌّؼبٌُ ػرٓ ؽش٠رك 

صرُ اٌّغّٛػرخ  Taskرظ١ًٍ اؽذ اٌظرفٛ  اٌّرشاد اػربفخ اٌّؼٍرُ ثزغٍغرٍٙب ٚثؼرذ٘ب اخز١ربس رج٠ٛرت 

Insert لِش صُ ٔخزبس اMilestones   ٟوّب فٟ اٌشىً الر- 

Task     →       Insert      →      Milestones 

 (4-6انشكم )

 ذحذيذ حذوز يشحهح اَرھاء
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ٚثؼذ رٌه ٔمَٛ ثزؾذ٠ذ فزشح أزٙبء اٌّؼٍُ ِٓ خلاي أششؽخ اٌٛلذ ِٓ خلاي اٌغؾت ٚالفلاد ثضس 

 -اٌفأسح ال٠غش ٚوّب ِٛػؼ ثبٌشىً ا٢رٟ  

 (4-7) انشكم 

 شكم انًؼهى )انحذز انُھائي( انثاسص

 Recurring Taskانًھاو انذوسيح 

رزةٍت اٌؼذ٠ذ ِٓ اٌّشبس٠غ ِٙبَ ِزىشسح ِضرً ؽؼرٛس اعزّبػربد اٌزرٟ رؾرذس ثشرىً دٚسٞ وربْ 

٠ىْٛ أعجٛػٟ أٚ شٙشٞ ، ٌٍٚم١بَ ثأٔشبء اٌّٙبَ اٌذٚس٠خ ٔؾذد اٌظف اٌّشاد أػربفخ ِّٙرٗ دٚس٠رخ 

  Taskصررُ ٔخزرربس لبئّررخ ِٕغررذٌخ ثبعررُ  Insertصررُ اٌّغّٛػررخ  Taskزج٠ٛررت ا١ٌررخ ٚثؼررذ٘ب ٔخزرربس اٌ

 -، ٚوّب ِٛػؼ فٟ اٌشىً أدٔبٖ   Recurring Taskٚٔخزبس الِش 

 

 

 

 

 

 

 

 

 انًھاو انذوسيح
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عر٠ٕٛخ ،  –شرٙش٠خ  –أعرجٛػ١خ  –ٚعزفزؼ ٔبفزح ٔمَٛ ِٓ خلاٌٙب ثبخز١بس ً٘ اٌّّٙخ اٌذٚس٠خ ١ِٛ٠خ 

، ٚوُ ِشح رىْٛ )ِضلاً ِشربْ فٟ اٌشٙش( ٚوزٌه اعُ اٌّّٙخ اٌذٚس٠خ ، ٚوزٌه ِذح اٌّّٙخ اٌذٚس٠خ 

 -ٚوّب ِٛػؼ فٟ اٌشىً ادٔبٖ  

  

 

 

 

 

 

 

 

 َافزج ضثظ انًھاو انذوسيح


